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CAN ICES-3 (A)/NMB-3(A)

For Canada

WARNING
This product contains chemicals known to cause cancer, 
birth defects and other reproductive harm. 

For California

Manufacturer:
ROLAND DG CORPORATION
1-6-4 Shinmiyakoda, Kita-ku, Hamamatsu-shi, Shizuoka-ken, 431-2103 JAPAN

The authorized representative in the EU:
Roland DG EMEA, S.L.
Parc Tecnologic del Valles C/ Ceramistes, 6 08290 Cerdanyola del Valles / Barcelona Spain

For EU Countories

 Roland DG Corp. has licensed the MMP technology from the TPL Group.

This system (including the housing and safety device) is a Class 1 laser product.

Complies with IEC 60825-1 Edition 2.0 (2007-03).
Complies with FDA performance standards for laser products except for deviations pursuant to Laser notice 
No.50 dated June 24, 2007.

Caution - Use of controls or adjustments or performance of procedures other than those specified herein may 
result in radiation exposure.

[Laser specifications of this system] (including the housing)
Max. output: 46.5 μW, Pulse duration: 3.0 μs, Wavelength: 655 nm

FEDERAL COMMUNICATIONS COMMIS-
SION RADIO FREQUENCY INTERFERENCE 

STATEMENT

NOTE:
This equipment has been tested and found to comply with 
the limits for a Class A digital device, pursuant to part 15 
of the FCC Rules.
These limits are designed to provide reasonable protec-
tion against harmful interference when the equipment is 
operated in a commercial environment. This equipment 
generates, uses, and can radiate radio frequency energy 
and, if not installed and used in accordance with the in-
struction manual, may cause harmful interference to radio 
communications. 
Operation of this equipment in a residential area is likely 
to cause harmful interference in which case the user will 
be required to correct the interference at his own expense.

Unauthorized changes or modification to this system can 
void the users authority to operate this equipment.

Use only I/O cables that have been designed and manufac-
tured specifically for this device.

For the USA

WARNING
This is a Class A product. In a domestic environment this 
product may cause radio interference in which case the 
user may be required to take adequate measures.

For EU Countories



For China

For EU Countories

产品中有毒有害物质或元素的名称及含量 

部件名称 

有毒有害物质或元素 

铅(Pb) 汞(Hg) 镉(Cd) 
六价铬 

(Cr(Ⅵ)) 

多溴联苯 

(PBB) 

多溴二苯醚 

(PBDE) 

印刷电路板 × ○ × ○ ○ ○ 

头部 × ○ ○ ○ ○ ○ 

壳体、底架 × ○ ○ ○ ○ ○ 

电源 × ○ × ○ ○ ○ 

其他（电缆、附件等） × ○ ○ ○ ○ ○ 

              

 ○：表示该有毒有害物质在该部件所有均质材料中的含量均在 GB/T26572-2011 标准规定的限量要求以下。 

 ×：表示该有毒有害物质至少在该部件的某一均质材料中的含量超出 GB/T26572-2011 标准规定的限量要求。

 

环保使用期限 

此标志适用于在中国国内销售的电子信息产品，表示环保使用期限的年数。 

所谓环保使用期限是指在自制造日起的规定期限内，产品中所含的有害物质 

不致引起环境污染，不会对人身、财产造成严重的不良影响。 

环保使用期限仅在遵照产品使用说明书，正确使用产品的条件下才有效。 

不当的使用，将会导致有害物质泄漏的危险。 
 

 

This product must be disposed of 
separately at your local waste recycling 
center. Do not dispose of in household 
waste bin. 

Bitte führen Sie dieses Produkt separat 
Ihrer örtlichen Entsorgungsstelle zu. 
Bitte nicht mit dem normalen Hausmüll 
entsorgen.

Ne jetez pas le produit avec vos 
ordures ménagères. Portez-le dans un 
centre recyclage des déchets.

Questo prodotto deve essere smaltito 
negli appositi contenitori per la raccolta 
differenziata, non buttare nel cestino 
dei rifiuti casalinghi.

Este producto debe devolverse al 
centro de reciclaje más cercano a su 
domicilio para su correcta eliminación. 
No lo tire a la basura.

Deite fora separadamente este produto 
no seu centro de reciclagem local. Não 
o deite fora no seu caixote do lixo.

Lever dit product in bij een lokaal 
afvalverzamelpunt. NIET met normaal 
huishoudelijk afval afvoeren.

Dette Produkt skal smides særskilt 
væk på den lokale affalds- og 
genbrugsstation. Må ikke smides ud 
sammen med almindeligt 
husholdningsaffald.

Tätä tuotetta ei saa hävittää 
normaalien talousjätteiden mukana, 
vaan se on toimitettava 
ongelmajätteiden keräilypisteeseen 
hävitettäväksi.

Produkten måste kasseras separat på 
din lokala återvinningscentral. Släng 
inte produkten tillsammans med 
hushållssoporna.

Μην πετάξετε το αντικείμενο αυτό στο 
καλάθι των απορριμμάτων. Αφαιρέστε 
τις μπαταρίες και προσκομίστε το στο 
τοπικό κέντρο ανακύκλωσης.
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 To Ensure Safe Use

Improper handling or operation of this machine may result in injury or damage to property. Points 
that must be observed to prevent such injury or damage are described as follows.

About  WARNING and  CAUTION Notices

 WARNING
Used for instructions intended to alert the user to the risk of death or severe injury 

should the unit be used improperly.

 CAUTION
Used for instructions intended to alert the user to the risk of injury or material 

damage should the unit be used improperly.

*Material damage refers to damage or other adverse effects caused with respect 

to the home and all its furnishings, as well to domestic animals or pets.

About the Symbols
The  symbol alerts the user to important instructions or warnings.

The specific meaning of the symbol is determined by the design contained within the  

symbol.

The symbol at left means “danger of electrical shock.”

The  symbol alerts the user to items that must never be carried out (are forbidden).

The specific meaning of the symbol is determined by the design contained within the  

symbol.

The symbol at left means the unit must never be disassembled.

The  symbol alerts the user to things that must be carried out.

The specific meaning of the symbol is determined by the design contained within the  

symbol.

The symbol at left means the power-cord plug must be unplugged from the outlet.
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 To Ensure Safe Use

 Incorrect operation may cause injury

 WARNING
Always unplug the power cord when at-
taching or removing parts and optional 
parts and when performing cleaning or 
maintenance that does not require the 
machine to be connected to a power 
source.
Attempting such operations while the ma-
chine is connected to a power source may 
result in injury or electrical shock.

Keep children away from the machine.
The machine includes areas and compo-
nents that pose a hazard to children and 
may result in injury, blindness, choking, or 
other serious accident.

Never attempt to disassemble, repair, or 
modify the machine.
Doing so may result in fire, electrical shock, 
or injury. Entrust repairs to a trained service 
technician.

Never operate the machine while tired 
or after ingesting alcohol or any medi-
cation.
Operation requires unimpaired judgment. 
Operating with impaired judgment may 
result in an accident.

Never climb or lean on the machine.
The machine is not made to support a per-
son. Climbing or leaning on the machine 
may dislodge components and cause a slip 
or fall, resulting in injury.

Be careful around the milling tool.
The milling tool is sharp. Broken milling 
tools are also dangerous. To avoid injury, 
exercise caution.

Never use a milling tool that has become 
dull. Perform frequent maintenance to 
keep the machine in good working order.
Inappropriate usage may result in fire or 
injury.

Never operate the machine if the cover 
is cracked or broken.
Doing so may result in injury. If the cover is 
cracked or broken, contact your authorized 
Roland DG Corp. dealer.

Be sure to follow the operation proce-
dures described in the user’s manual. 
Never allow anyone unfamiliar with the 
usage or handling of the machine to 
touch it.
Improper handling of the machine may lead 
to unforeseen injuries.

Conduct operations in a clean, brightly 
lit location.
Working in a location that is dark or cluttered 
may lead to an accident, such as becoming 
caught in the machine as the result of an 
inadvertent stumble.

Never attempt to disassemble, repair, or 
modify the machine.
Doing so may result in fire, electrical shock, or in-
jury. Entrust repairs to a trained service technician.
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 To Ensure Safe Use

 WARNING
Connect to an electrical outlet that com-
plies with this machine’s ratings (for 
voltage, frequency, and current).
Incorrect voltage or insufficient current may 
cause fire or electrical shock.

Rating Label

If sparks, smoke, burning odors, unusual 
sounds, or abnormal operation occurs, 
immediately unplug the power cord. 
Never use if any component is damaged.
Continuing to use the machine may result in 
fire, electrical shock, or injury. Contact your 
authorized Roland DG Corp. dealer.

Never use outside or in any location 
where exposure to water or high humid-
ity may occur. Do not touch the power 
cord, plug, or electrical outlet with wet 
hands.
Doing so may result in fire or electrical shock.

 Danger of electrical short, electrical shock, or fire

Position so that the power plug is within 
immediate reach at all times.
This is to enable quick disconnection of the 
power plug in the event of an emergency. In-
stall the machine next to an electrical outlet. 
Also, provide enough empty space to allow 
immediate access to the electrical outlet.

Do not use with any power supply other 
than the dedicated AC adapter.
Use with any other power supply may lead 
to fire or electrical shock.

Never place any flammable object near 
the machine. Never use a combustible 
aerosol spray nearby. Never use in any 
location where gases can accumulate.
Combustion or explosion could occur.

Handle the power cord, plug, and electri-
cal outlet correctly and with care. Never 
use any article that is damaged.
Using a damaged item may result in fire or 
electrical shock.

When using an extension cord or power 
strip, use one that adequately satisfies 
the machine's ratings (for voltage, fre-
quency, and current).
Use of multiple electrical loads on a single 
electrical outlet or use of a lengthy extension 
cord may cause a fire.

Never use the machine for any purpose 
for which it is not intended, or use the 
machine in an excessive manner that 
exceeds its capacity.
Doing so may result in injury or fire.

 Danger of pinching, entanglement, and burns

 WARNING
Securely fasten the milling tool and ma-
terial in place. After securing in place, 
make sure no spanners or other articles 
have inadvertently been left behind.
Otherwise, such articles may be thrown 
from the machine with force, posing a risk 
of injury.

Exercise caution to avoid being pinched 
or becoming caught.
Inadvertent contact with certain areas may 
cause the hand or fingers to be pinched or 
become caught. Use care when performing 
operations.
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 To Ensure Safe Use

 WARNING
Do not use the included power cord and 
AC adapter with any other product.

Never allow any foreign object to get 
inside. Never expose the machine to 
liquid spills.
Inserting objects such as coins or matches 
or allowing beverages to be spilled into the 
ventilation ports may result in fire or electri-
cal shock. If anything gets inside, immedi-
ately disconnect the power cord and contact 
your authorized Roland DG Corp. dealer.

If the machine will not be used for a long 
period, disconnect the power cord.
This prevents accidents caused by unex-
pected electric leakage or unintentional start 
of the machine.

For accessories (optional and consum-
able items, power cord, and the like), use 
only genuine articles compatible with 
this machine.
Incompatible items may lead to an accident.

 Important notes about the power cord, plug, and electrical outlet.

Never place any object 
on top of or subject the 
power cord to damage.

 

Never bend or twist 
with undue force.

 

Never pull with undue 
force.

Never bundle, bind, or 
roll up.

Never allow to get wet. Never subject to heat. Dust may cause fire.

 This is a heavy machine.

 CAUTION
Install in a level and stable location.
Installation in an unsuitable location may 
cause the machine to fall or tip over.
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 To Ensure Safe Use

 Warning Labels

Warning labels are affixed to the machine to make areas of danger immediately clear. The mean-
ings of these labels are as follows. Be sure to heed their warnings. Also, never remove the labels 
or allow them to become obscured.

Caution: High Temperature
Do not touch immediately 
after imprinting

 The heads become hot.

 WARNING
Never touch the heads immediately after 
imprinting has finished.
Doing so may cause burns.
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 Pour utiliser en toute sécurité

La manipulation ou l’utilisation inadéquate de cet appareil peuvent causer des blessures ou des 
dommages matériels. Les précautions à prendre pour prévenir les blessures ou les dommages 
sont décrites ci-dessous.

Avis sur les avertissements

 ATTENTION
Utilisé pour avertir l’utilisateur d’un risque de décès ou de blessure grave en cas de 

mauvaise utilisation de l’appareil.

 PRUDENCE
Utilisé pour avertir l’utilisateur d’un risque de blessure ou de dommage matériel en 

cas de mauvaise utilisation de l’appareil.

* Par dommage matériel, il est entendu dommage ou tout autre effet indésirable 

sur la maison, tous les meubles et même les animaux domestiques.

À propos des symboles
Le symbole  attire l’attention de l’utilisateur sur les instructions importantes ou les 

avertissements.

Le sens précis du symbole est déterminé par le dessin à l’intérieur du symbole .

Le symbole à gauche signifie « danger d’électrocution ».

Le symbole  avertit l’utilisateur de ce qu’il ne doit pas faire, ce qui est interdit.

Le sens précis du symbole est déterminé par le dessin à l’intérieur du symbole .

Le symbole à gauche signifie que l’appareil ne doit jamais être démonté.

Le symbole  prévient l’utilisateur sur ce qu’il doit faire.

Le sens précis du symbole est déterminé par le dessin à l’intérieur du symbole .

Le symbole à gauche signifie que la fiche du câble d’alimentation doit être débranchée 

de la prise.
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 Pour utiliser en toute sécurité

 ATTENTION
To u j o u r s  d é b r a n c h e r  l e  c â b l e 
d’alimentation lors de la fixation ou du 
retrait de pièces et de pièces en option et 
du nettoyage ou des travaux d’entretien 
qui n’exigent pas un branchement de 
l’appareil à une source d’alimentation.
Tenter ces opérations pendant que l’appareil 
est branché à une source d’alimentation peut 
causer des blessures ou un choc électrique.

Garder les enfants loin de l’appareil.
L’appareil comporte des zones et des composants 
qui présentent un danger pour les enfants et qui 
pourraient causer des blessures, la cécité, la suf-
focation ou d’autres accidents graves.

Ne jamais tenter de démonter, de réparer 
ou de modifier l’appareil.
Le non-respect de cette consigne risque de 
provoquer un incendie, un choc électrique 
ou des blessures. Confier les réparations 
à un technicien ayant la formation requise.

Ne jamais faire fonctionner l’appareil 
après avoir consommé de l’alcool ou des 
médicaments, ou dans un état de fatigue.
L’utilisation de l’appareil exige un jugement 
sans faille. L’utilisation avec les facultés af-
faiblies pourrait entraîner un accident.

Ne jamais grimper ni s’appuyer sur l’appareil.
L’appareil n’est pas conçu pour sup-
porter le poids d’une personne. Grimper 
ou s’appuyer sur l’appareil peut déplacer 
des éléments et causer un faux pas ou une 
chute, ce qui causerait des blessures.

Être attentif dans le périmètre de l’outil 
de coupe.
L’outil de coupe est acéré. Les outils de 
coupes brisés sont aussi dangereux. Faire 
preuve de prudence pour éviter les blessures.

Ne jamais utiliser un outil de coupe 
émoussé. Procéder fréquemment aux 
travaux d’entretien pour garder l’appareil 
en bon état de fonctionnement.
L’utilisation inappropriée peut provoquer un 
incendie ou des blessures.

Ne pas utiliser l’appareil si le couvercle 
est fissuré ou brisé.
Le non-respect de cette consigne peut cau-
ser des blessures. Si le couvercle est fissuré 
ou brisé, communiquer avec le représentant 
Roland DG Corp. autorisé.

S’assurer de suivre les procédures d’utili-
sation décrites dans le manuel utilisateur. 
Ne jamais permettre à des personnes non 
formées à l’utilisation ou à la manipula-
tion de l’appareil de le toucher.
Une manipulation inappropriée de l’appareil 
peut entraîner des blessures imprévues.

Utiliser l’appareil dans un endroit propre 
et bien éclairé.
Travailler dans un endroit sombre ou en-
combré peut entraîner un accident; l’utili-
sateur risque, par exemple, de trébucher 
malencontreusement et d’être coincé par 
une partie de l’appareil.

Ne jamais tenter de démonter, de réparer 
ou de modifier l’adaptateur de c.a.
Le non-respect de cette consigne risque de 
provoquer un incendie, un choc électrique 
ou des blessures. Confier les réparations 
à un technicien ayant la formation requise.

 Une utilisation incorrecte peut causer des blessures
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 Pour utiliser en toute sécurité

 ATTENTION
Brancher à une prise électrique con-
forme aux caractéristiques de cet ap-
pareil (tension, fréquence et courant).
Une tension incorrecte ou un courant insuffisant 
peuvent causer un incendie ou un choc électrique.

Caractéristiques

S’il se produit des étincelles, de la fumée, une 
odeur de brûlé, des bruits inhabituels ou un fonc-
tionnement anormal, débrancher immédiatement 
le câble d’alimentation.Ne jamais utiliser si un 
composant est endommagé.
Continuer à utiliser l’appareil peut causer un incendie, 
un choc électrique ou des blessures. Communiquer 
avec le représentant Roland DG Corp. autorisé.

Ne jamais utiliser à l’extérieur ni à un endroit 
où l’appareil risque d’être exposé à l’eau ou 
à une forte humidité. Ne pas toucher le câble 
d’alimentation, la fiche ou la prise électrique 
avec des mains mouillées.
Le non-respect de cette consigne risque de 
provoquer un incendie ou un choc électrique.

Placer l’appareil de façon à ce que la 
fiche soit facile d’accès en tout temps.
Ainsi, l’appareil pourra être débranché rapidement 
en cas d’urgence. Installer l’appareil près d’une prise 
électrique. En outre, prévoir suffisamment d’espace 
pour que la prise électrique soit facile d’accès.

Ne pas utiliser une source d’alimentation au-
tre que celle fournie par l’adaptateur CA dédié.
L’utilisation de l’appareil avec une autre 
source d’alimentation peut provoquer un 
incendie ou un choc électrique.

Ne jamais placer d’objet inflammable à 
proximité de l’appareil. Ne jamais utiliser de 
produit inflammable en aérosol à proximité 
de l’appareil. Ne jamais utiliser l’appareil dans 
un endroit où des gaz peuvent s’accumuler.
Une combustion ou une explosion pour-
raient se produire.

Manipuler le câble d’alimentation, la fiche et 
la prise électrique correctement et avec soin. 
Ne jamais utiliser un article endommagé; 
cela pourrait provoquer un incendie ou un 
choc électrique.

Si une rallonge ou une barre multiprise 
sont utilisées, s’assurer qu’elles cor-
respondent aux caractéristiques de 
l’appareil (tension, fréquence et courant).
Surcharger une prise unique ou utiliser une 
longue rallonge peuvent causer un incendie.

Ne jamais utiliser l’appareil à des fins autres 
que celles pour lesquelles il est conçu. Ne ja-
mais l’utiliser de manière abusive ou excessive.
Le non-respect de cette consigne peut 
provoquer des blessures ou un incendie.

 ATTENTION
Fixer solidement l’outil de coupe et la 
pièce à travailler. Une fois qu’ils sont so-
lidement fixés, s’assurer qu’aucun outil ni 
aucun autre objet n’a été laissé en place.
Si tel était le cas, ces objets pourraient être 
projetés avec force hors de l’appareil et 
causer des blessures.

Faire preuve de prudence pour éviter 
l’écrasement ou le coincement.
La main ou les doigts peuvent être écrasés 
ou coincés s’ils entrent accidentellement 
en contact avec certaines surfaces. Faire 
preuve de prudence lors de l’utilisation de 
l’appareil.

 Certains éléments peuvent présenter un risque de pincement, d’emmêlement, de brûlure ou d’autres dangers.

 Risque de décharge ou de choc électrique, d’électrocution ou d’incendie
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 Pour utiliser en toute sécurité

 ATTENTION
Ne pas utiliser le câble d’alimentation 
ni l’adaptateur CA fournis avec d’autres 
produits.

Ne jamais insérer d’objet étranger dans 
l’appareil. Ne jamais exposer l’appareil 
aux déversements de liquides.
L’insertion d’objets comme des pièces de 
monnaie ou des allumettes, ou le déverse-
ment de liquides dans les orifices de ventila-
tion peuvent provoquer un incendie ou un choc 
électrique. Si un objet ou du liquide s’infiltre 
dans l’appareil, débrancher immédiatement 
le câble d’alimentation et communiquer avec 
le représentant Roland DG Corp. autorisé.

Si l’appareil doit rester inutilisé pendant 
une longue période, débrancher le câble 
d’alimentation.
Cela peut prévenir les accidents en cas de 
fuite de courant inattendue ou de démar-
rage accidentel.

Utiliser uniquement des accessoires 
d’origine (accessoires en option et 
consommables, câble d’alimentation et 
autres articles similaires) compatibles 
avec l’appareil.
Les articles incompatibles peuvent entraî-
ner des accidents.

 Remarques importantes à propos du câble d’alimentation, de la fiche et de la prise électrique.

Ne jamais déposer d’objets 
sur le câble d’alimentation 

ou faire quoi que ce soit 
qui pourrait l’endommager.

Ne jamais plier ni 
tordre avec une force 

excessive.

Ne jamais tirer avec une 
force excessive.

Ne jamais lier ni 
enrouler.

Ne pas exposer à l’eau. Ne pas exposer à la 
chaleur.

La poussière peut 
causer un incendie.

 PRUDENCE
Installer l’appareil à un endroit stable 
et plat.
Installer l’appareil à un endroit inapproprié 
peut provoquer sa chute ou son renversement.

 Cet appareil est lourd.
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 Pour utiliser en toute sécurité

Des vignettes d’avertissement sont apposées sur l’appareil pour qu’il soit facile de repérer les 
zones dangereuses. La signification des vignettes est donnée ci-dessous. Respecter les aver-
tissements. Ne jamais retirer les vignettes et ne pas les laisser s’encrasser.

Attention : température élevée.
Ne pas toucher immédiatement 
après l’impression.

 ATTENTION
Ne jamais toucher la tête de l’appareil im-
médiatement après la fin de l’impression.
Le non-respect de cette consigne peut 
causer des brûlures.

 La tête devient chaude.

 Vignettes d’avertissement
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Important Notes on Handling and Use

This machine is a precision device. To ensure the full performance of this machine, be sure to 
observe the following important points. Failure to observe these points may not only result in 
loss of performance but may cause faulty operation or a malfunction.

This Machine Is a Precision Device

• Handle carefully, and never subject the machine to impacts or excessive force.

• Never attempt to imprint material that is not covered by the specifications.

Install in a Suitable Location

• Install in a location that meets the specified conditions for temperature, relative humidity, and the like.

• Install in a stable location offering good operating conditions.

• Never install in an environment where silicone substances (oil, grease, spray, etc.) are present. Doing so 
may cause poor switch contact.

Moving the Machine

• When moving the machine, be sure to support it at the bottom using two hands. Attempting to move 
the machine by holding it at a different location may result in damage.

• When moving the machine, be sure to attach the base unit and the retainers. In particular, moving the 
machine without attaching the retaining materials may result in damage. Be sure to also remove included 
items such as material retainers and the grid table.
 " P.133 “Moving the Machine”

About Imprinting

• Never attempt to imprint on the areas of a material that have lines or holes.

• Imprint results will vary according to the hardness of the material. Before performing actual imprinting, 
we recommend carrying out a test imprint.

• Repeatedly performing imprinting with no material loaded can lead to pin damage and head malfunctions.
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About the User's Manuals

Documentation Included with the Machine
The following documentation is included with the machine.

MPX-95 User’s Manual (this document)
This contains important notes for ensuring safe use as well as detailed information on how to install and 
operate the machine. This manual also provides instructions for how to install and use the included software.
Be sure to read this first.

METAZA Driver 2 Help (electronic-format manual)

METAZAStudio Help (electronic-format manual)

SFEdit2 Help (electronic-format manual)

Dr. Engrave Help (electronic-format manual)

This user's manual is intended for viewing on a computer screen. Installing the respective programs makes 
these available for viewing. The Dr. Engrave help becomes visible after each software is installed.

 " P.27 “How to Open the METAZA Driver 2 Help”
 " P.28 “How to Display Help for Software”
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About the Machine

Features
This machine is a metal printer with the following features.

High-Quality Marking from Simple Input

Images are imprinted by striking detailed points using a marking pin mounted in a head.
You can easily create imprint data using dedicated software.

Laser Pointers for Easy Position Alignment

Standard-equipped laser pointers allow you to perform imprint alignment easily with just one push of a button.

Variable Imprinting for Continuous Printing

Even when printing different multiple codes in a row, you can continue printing without stopping to enter 
individual data to be imprinted.

Support for a Wide Variety of Material

Imprinting is also possible with thicker (taller) material.
In addition, by using the material retainer designed to handle a variety of material shapes, the available mate-
rial choices becomes even more varied.
*The material retainers are available as an included item or an optional kit.
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About the Optional Kit
Material retainers capable of handling a variety of material shapes are separately available.
Purchase those material retainers that match the application.
For purchasing information, contact your authorized Roland DG Corp. dealer or visit our website (http://www.
rolanddg.com/).

Gift Kit

This kit allows you to imprint names, decorations, and other markings onto accessories. When used with a 
dedicated vise, this kit makes it possible to imprint even on small items that are not easily secured, such as 
watches and pens. For more information, refer to “Using the Gift Kit” in the manual included with the Gift Kit.

DPM Kit

This kit allows you to add numbering to medical instruments and industrial products efficiently. With the DPM 
Kit, you can directly imprint thin medical instruments that cannot be easily secured as well as on variously 
shaped instruments. In addition, using the included software makes it possible to create and imprint 2D sym-
bols. For more information, refer to “Using the DPM Kit” in the manual included with the DPM Kit.

19
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About the Machine

Names of Components

Main Unit

Front

Base unit
The base unit is composed of the following two parts, 
which can be installed or removed from the machine.

 " P.37 "Installing/Removing the Base Plate"

Cover

Head unit

Hold the middle area of the 
cover when opening the cover.

Knob

Head

Base unit hook
(One each for the left and right)

Base plate

Base table

20
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Side

Power-cord 
connector

USB connector

Power/Movement buttonLaser pointer button

Head (MPH-90)

This print head includes a marking pin at the tip. A diamond is attached to the tip of the marking pin. Because 
the head is a consumable part, replace it at the appropriate time.

 " P.113 "Head Replacement"

Marking pin

Material Retainers

Grid table, adhesive sheet
When securing the material using the grid table, the adhesive sheet is placed on the grid table and then the 
material is placed on the sheet. This lets you immobilize objects without having to use commercially available 
tape or the like.

 " P.61 "Load the material on the grid table."

Adhesive sheet

Grid table

21
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About the Machine

Checking the Included Items
The following items are packed together with the unit. Make sure they are all present and accounted for.

AC adapter (1) Power cord (1) USB cable (1)

Grid table (1) Adhesive sheet (1) Head (MPH-90) (1)*1

Head caps (round bottom) (10)*2 Test material (Brass-plated 
plates) (4)

Test material (MD-NI) (1)

Hexagonal wrench (1) Roland Software Package 
CD (1)

User’s manual (this document) 
(1)

*1 : Attached to the machine before shipment.
*2 : One only attached to the machine before shipment. The remaining components are packaged as 

included items.
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Installing the Software

System Requirements

Operating system (OS)* Windows 10, 8.1, 7 (32-bit and 64-bit versions)

Processor Intel® Core 2 Duo or greater (Core i5 or greater recommended)

Memory 1 GB or greater (2 GB or more recommended)

Optical drive CD-ROM drive

Video card and monitor At least 16 bit colors (High Color) with a resolution of 1024 × 768 or 
more recommended

Free hard-disk space 
required for installation 25 MB

* As this software is a 32-bit application, it runs on WOW64 (or Windows-On-Windows 64) under the 
64-bit version of Windows.

For the latest information, see the Roland DG Corp. website (http://www.rolanddg.com).

The Software You Can Install and Set Up

METAZAStudio This is a program for creating imprint data. It enables you import and crop 
images to imprint, and perform editing to add text, boxes, and the like.

SFEdit2
This program lets you create and edit stroke fonts. Stroke fonts are line 
drawings created by automatically extracting the center lines from a 
TrueType font. You can use the generated stroke fonts as fonts with 
METAZAStudio.

MPX-95 Head Manager This is a utility for adjusting the head. Run it when you replace the head 
or adjust the marking pin.

Dr. Engrave
This is text and image imprinting software that lets you create imprint 
data. You can use TrueType fonts registered in Windows. It also has stroke 
characters.

METAZA Driver 2 This Windows driver is required for sending data from a computer to 
the machine.
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Installing the Driver and the Software

IMPORTANT

Make sure to connect the machine to the computer by following the given procedure. Failure to follow the 
correct procedure may make installation impossible.

Procedure

A Before you start installation and setup, make sure the USB cable is NOT connected.

B Log on to Windows as an administrator or as a member of the Administrators group.

C Insert the Roland Software Package CD into the computer.
When the automatic playback window appears, click [Run menu.exe]. If the [User Account Control] 
window appears, click [Allow] or [Yes]. The install menu appears automatically.

D Click [Install].

The drivers and software that will be installed will be displayed.

E Click [OK].

METAZA Driver 2 and each software will be installed all at once.
 " P.23 "The Software You Can Install and Set Up"

You can install METAZA Driver 2 and each software separately.
 " P.126 "Installing the Driver Separately", P.129 "To Install Software Separately"
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F Select [Install], select [Roland MPX-95] as the model name, select [USB] as the port, 
and then click [Start].

Installation starts. Proceed by following the on-screen instructions.

Perform the following actions if the screens shown below appear during installation.

Windows 10

Click [Install].

Windows 8.1

Click [Install].

Windows 7

Click [Install this driver software anyway].

G Follow the displayed instructions and continue with the installation.
Installation information for each software item will be displayed automatically as needed.
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H When the following window appears, click [OK].

This completes the installation of all items.

I When installation is complete, click  in the installation menu.

J Remove the Roland Software Package CD from the computer.

IMPORTANT

At this point, METAZAStudio Driver 2 has not yet been installed.
Installation will occur automatically when the machine is connected to the computer during the 
next steps.
 " P.31 "Connecting the Machine to a Computer"

How to Open the METAZA Driver 2 Printing Preferences Screen

The Printing Preferences screen can be displayed after METAZA Driver 2 installation is complete.

A Display the printer icon.

Windows 10 and 8.1

1 Right-click the [Start] menu on the computer.
2 Click [Control Panel].
3 Click [View devices and printers] or [Devices and Printers].

Windows 7

1 Click the [Start] menu.
2 Click [Devices and Printers].

B Right-click the [Roland MPX-95] icon, and then click [Printing preferences].
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The METAZA Driver 2's Printing Preferences screen opens.

How to Open the METAZA Driver 2 Help

Open the METAZA Driver 2 Printing Preferences screen, and then click [Help].
 " P.26 "How to Open the METAZA Driver 2 Printing Preferences Screen"
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How to Start The Software

Windows 10 and 7

1 Click the [Start] button.
2 Click [All Apps] ([All Programs] or [Programs] for Windows 7).
3 Click the icon for [(Name of software to use)] under the [(Name of software to use)] 

folder.

Windows 8.1

1 On the [Start] screen, click .
2 On the [Apps] screen, click [(Name of software to use)].

How to Display Help for Software

Start the software, and then click [Help] → [Table of Contents] from the menu.
 " P.28 "How to Start The Software"
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Installation
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Installation Environment

WARNING Never install outside or in any location where exposure to water or high 
humidity may occur.
Current leakage may cause electrical shock or fire.

WARNING Never install the machine close to any flammable object or in a gas-filled 
location.
Combustion or explosion could occur.

WARNING Position so that the power plug is within immediate reach at all times.
This is to enable quick disconnection of the power plug in the event of an emer-
gency. Install the machine next to an electrical outlet. Also, provide enough 
empty space to allow immediate access to the electrical outlet.

CAUTION Install in a level and stable location.
Failure to do so may result in falling of the machine, leading to injury.

• Never install in a location subject to wide fluctuations in temperature or humidity.

• Never install in a location subject to shaking or vibration.

• Never install in a location where the floor is tilted, not level, or unstable.

• Never install in a dusty or dirty location, or out of doors.

• Never install in a location exposed to direct sunlight or near air-conditioning or heating equipment.

• Never install in a location exposed to considerable electrical or magnetic noise or to other forms of 
electromagnetic energy.

• Never install in an environment where silicone substances (oil, grease, spray, etc.) are present. Doing so 
may cause poor switch contact.
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Removing the Retainers
Retaining materials are attached to protect the machine from vibration during shipment. When installation is 
complete, remove and save these components.

Removing the Retainers

The machine is secured with retainers and screws at five points (  through  below). Remove all the screws 
and retainers with the included hexagonal wrench. Any retainers or screws that remain may cause faulty 
operation or breakdown when the power is switched on.

Items Used Retainer

Hexagonal 
wrench

Retainer A (2) Retainer B (1 each for L and R) Retaining screws 
(7)

Retainer B

The machine is 
secured on the 
left and the right.

Retainer A

Retainer A

Storing

The retainers and screws are required when moving the machine to a different location. Keep the removed 
screws and retainers (A) by mounting them to the lower back side of the machine. Retainer B cannot be at-
tached to the machine and must be stored separately to prevent them from getting misplaced.

Rear view
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Connecting the Machine to a Computer

WARNING Do not use with any electrical power supply that does not meet the ratings 
displayed on the AC adapter.
Use with any other power supply may lead to fire or electrical shock.

WARNING Never use any AC adapter or power cord other than the AC adapter and 
power cord included with the machine.
Use with any other power supply may lead to fire or electrical shock.

WARNING Never attempt to disassemble, repair, or modify the AC adapter. 
Doing so may result in fire, electrical shock, or injury. Entrust repairs to a trained 
service technician.

WARNING Never attempt to disassemble, repair, or modify the AC adapter.
Doing so may result in fire, electrical shock, or injury. Entrust repairs to a trained 
service technician.

WARNING When using an extension cord or power strip, use one that adequately 
satisfies the machine’s ratings (for voltage, frequency, and current).
Use of multiple electrical loads on a single electrical outlet or use of a lengthy 
extension cord may cause a fire.

Procedure

A Switch on the power to the machine.
Do not forget to loosen the head's stopper.
 " P.32 "Switching On the Power"

B Connect the machine to the computer using the USB cable.

IMPORTANT

• Never connect multiple machines to one computer.

• Please use the included USB cable.

• Do not use a USB hub.

METAZA Driver 2 and the individual software will be installed automatically.

Machine

Electrical 
outlet

Power cord

AC adapter

Computer
31



Switching the Power On and Off

Switching On the Power

Procedure

A Open the bottom cover of the machine.

B Loosen the head's stopper.
Rotate the knob once.

Stopper

Loosen

C Press the Power/Movement button.
The head moves to the left rear, and the lamp of the Power/Movement button is turned ON. This 
operation is called initialization.
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IMPORTANT : When the power lamp remains blinking

An initialization error. Loosen the stopper of the head, and then press the Power/Movement button. The error is 
cleared, and the power lamp is lit.
If the lamp continues to blink, refer to the following section.
 " P.118 "The [Power/Movement] Button Is Blinking."

Switching Off the Power

Procedure

Hold down the Power/Movement button for one second or longer.

The light turns off and the power is switched off.
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Installing/Removing the Base Unit

The base unit can be installed or removed from the machine. The base unit includes the base table and the 
base plate, both of which can be combined as necessary to allow for imprinting on variously shaped material.

 " P.42 "Preparing the Material"

Base table

Base plate

Base unit

Main unit

• Switch off the power before installing or removing the base unit (or the base plate). The base unit (or 
base plate) can be installed or removed even with the power switched on, but contact with the head 
area can cause the imprint position to shift.

• Store the removed base table, base plate, and grid table horizontally in a stable location.
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Installing/Removing the Base Table (or Grid Table) to/from the Base Plate

MEMO

• The base table (or grid table) can be installed/removed with the base plate attached to the machine.

• Not only the base table but also the grid table can be directly mounted to the base plate.
 " P.61 "2.  Load the material on the grid table."

Removing the Base Table (or Grid Table)

Procedure

A Open the bottom cover of the machine.

B Lift the base table (or grid table) straight up and remove it from the base plate.
Lift the base table with both hands.

For a Base Table For a Grid Table
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Installing the Base Table (or Grid Table)

Procedure

A Open the bottom cover of the machine.

B Check whether the base plate is installed.

C Place the base table (or grid table) on the base plate.
Place the protrusions on the bottom of the base table (or grid table) into the holes on the base plate.

For a Base Table For a Grid Table

Align with 
the corners.
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Installing/Removing the Base Plate

MEMO

• The base unit is installed when shipped from the factory.

• After verifying that the grid table and the base unit (or base plate) are mounted on the machine, set the 
material.
 " P.61 "2.  Load the material on the grid table."

Removing the Base Plate

Procedure

A Open the bottom cover of the machine.

B Remove the hooks from both sides of the machine.

C Hold the base plate with both hands and pull it straight forward.
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Installing the Base Plate

Procedure

A Open the bottom cover of the machine.

B Hold the base plate with both hands, and insert the protrusions on the machine into 
the holes on the base plate.

Insert straight into the holes in 
two locations at the same time.

Machine

Base plate

C Set the hooks on both sides of the machine so that they catch on the base plate, and 
then lock the hooks.

OK Not OK Not OK

IMPORTANT

Make sure the hooks on both sides of the machine are securely locked. If the lock is not secure, or if only one 
side is locked, the base unit may move and cause the imprint position to become shifted.

1

G
etting 

Started

Installing/Removing the Base Unit

38



Chapter 2 Imprinting
Preparing for Imprinting .............................................................................................40

Checking Imprint Workflow ........................................................................................ 40

Specifying Output Destination for METAZAStudio .................................................... 41

Preparing the Material ............................................................................................... 42

Creating Imprint Data .................................................................................................48

Starting METAZAStudio ............................................................................................. 48

METAZAStudio Screen .............................................................................................. 49

Step 1: Determine the Shape and Size of Material ................................................... 51

Step 2: Import the Image ........................................................................................... 56

Step 3: Type in the Text. ............................................................................................ 58

Step 4: Save Imprinting Data..................................................................................... 59

Imprinting ...................................................................................................................60

Mounting the Material ................................................................................................ 60

Making Imprints ......................................................................................................... 66

Stopping Imprint Operations ......................................................................................68

Stopping Imprinting Operations ................................................................................. 68

Deleting Data from Imprint Queue ............................................................................. 69

Configuring Advanced Settings / Processing Images ................................................70

Processing Images .................................................................................................... 70

Tips and Tricks for Text Layout .................................................................................. 75

Creating/Editing a Stroke Character Font.................................................................. 80

Checking and Adjusting Finished Result of an Image ............................................... 88

Creating Variable Imprinting Data .............................................................................. 90

Imprinting on Curved Surfaces .................................................................................. 96

Registering a Wide Variety of Material .................................................................... 101

Registering a Composition and Adjusting the Striking Force................................... 102

Changing Basic Driver Settings ............................................................................... 104

Other Operations Available with METAZAStudio ..................................................... 105

About Dr. Engrave ................................................................................................... 105

Imprinting Thicker (Taller) Material .......................................................................... 106

2

Im
printing

39



40

Checking Imprint Workflow

Specifying Output Destination for METAZAStudio (P. 41)

Switch on the power of the machine and select it as the output destination for the computer.

Preparing the Material (P. 42)

Check the several conditions for thickness, hardness, and the like that must be met for a material 
to be imprinted.

Creating Imprint Data (P. 48)

Create imprinting data using METAZAStudio.

Mounting the Material (P. 60)

Set the material on the machine.

Making Imprints (P. 66)

Output the imprint data from METAZAStudio.

Preparing for Imprinting
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Preparing for Imprinting

Specifying Output Destination for METAZAStudio

Procedure

A Switch on the power to the machine.
 " P.32 "Switching On the Power"

B Starting METAZAStudio.
 " P.28 "How to Start The Software"

C Click [File] → [Set up the printer].

The [Print Setup] dialog box appears.

D Select the printer to which data will be output.
1 Select [Roland MPX-95].
2 Click [OK].
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Preparing for Imprinting

Preparing the Material
In order for a material to be used for imprinting with this machine, the material must meet all of the following 
conditions. For details on these conditions, refer to the respective pages mentioned.

• Imprint surface hardness (P. 42)

• Thickness (Height) (P. 42)

• Size (P. 45)

• Shape (P. 46)

• Conditions for material when imprinting curved surfaces (when the imprint surface is curved) (P. 47)

Please note that these conditions are limited to use of this machine and the items included with it. Conditions 
may vary if the optional kit is used.

Imprint Surface Hardness

Vickers hardness (HV) of 200 or less
Materials which may crack or split by imprinting (such as glass, stone, precious stones, china, and porcelain) 
cannot be imprinted even if hardness is within the preceding range. Attempting to imprint such material may 
damage the machine. For information on the hardness of the material surface, please contact the shop where 
you bought the material or the manufacturer of the material.

Thickness (Height)

The imprintable thickness (height) varies depending on the combination of the base unit.
 " P.37 "Installing/Removing the Base Plate"

Base table

Base plate

Base unit

Main unit
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Preparing for Imprinting

When using the base unit:
Material thickness 

(height) Base table

0.3 mm to 40 mm 
(0.01 in. to 1.6 in.) Used

40 mm to 70 mm 
(1.6 in. to 2.8 in.) Not used

* Imprinting 40 mm (1.6 in.) material is possible regardless of whether a base table is used.

Base table + Base plate

0.3 mm to 40 mm (0.01 in. to 1.6 in.)

Base table

Base plate

Material

Grid table

Base plate only

40 mm to 70 mm (1.6 in. to 2.8 in.)

Base plate

Material
Grid table
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Preparing for Imprinting

When not using the base unit
If the imprint surface of a material is set within the imprintable area up to 70 mm (2.8 in.) from the tip of 
the head cap (area reached by the marking pin), material with a thickness (height) equal to or greater than 
those listed above can also be imprinted.

Head cap

70 mm (2.8 in.)
Area that can be imprinted

80 mm  
(3.2 in.)

118 mm (4.6 in.)
(Distance from machine)

* Securing the grid table is not possible if the base unit is not used. In addition to placing a support to 
keep the material horizontal, use commercially available tape or some other means to secure the grid 
table to the working surface.

* The imprint position alignment accuracy decreases when the base unit is not used. Perform a test 
imprint and fine-adjust the position before imprinting for production.

 " P.106 "Imprinting Thicker (Taller) Material"
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Preparing for Imprinting

Size

The instrument is large enough to be firmly secured.
With this machine, you can use the adhesive sheet to secure the material. Though it is acceptable even if the 
size of the instrument protrudes from the adhesive sheet, the essential requirement is that the instrument 
can be firmly secured.

The following table shows the imprintable thickness and size by material. However, note that you cannot use 
material that warps during imprinting even if the thickness and size are within the ranges specified below. If 
you use such material, warped material might come into contact with the head, damaging the marking pin.

Material Thickness Width and Length (general 
guide)

Aluminum

2.0 mm 
(0.08 in.)

Length (or width) of 60 mm 
(2.4 in.) or less

1.5 mm 
(0.06 in.)

Length (or width) of 40 mm 
(1.6 in.) or less

1.0 mm 
(0.04 in.)

Length (or width) of 30 mm 
(1.2 in.) or less

0.5 mm 
(0.02 in.)

Length (or width) of 20 mm 
(0.8 in.) or less

0.3 mm 
(0.01 in.)

Length (or width) of 20 mm 
(0.8 in.) or less

Brass or copper

2.0 mm 
(0.08 in.)

Length (or width) of 60 mm 
(2.4 in.) or less

1.5 mm 
(0.06 in.)

Length (or width) of 40 mm 
(1.6 in.) or less

1.0 mm 
(0.04 in.)

Length (or width) of 30 mm 
(1.2 in.) or less

0.5 mm 
(0.02 in.)

Length (or width) of 15 mm 
(0.6 in.) or less

0.3 mm 
(0.01 in.)

Length (or width) of 15 mm 
(0.6 in.) or less

Stainless steel

2.0 mm 
(0.08 in.)

Length (or width) of 60 mm 
(2.4 in.) or less

1.0 mm 
(0.04 in.)

Length (or width) of 40 mm 
(1.6 in.) or less

* Conditions may vary if the optional kit material retainers are used.
 " User's Manual for the individual material retainers
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Preparing for Imprinting

Shape

There must be no unevenness on the imprint surface.
Imprinting is not possible for material that comes into contact with the moving part of the machine when 
being set or during imprinting.

The edge of the material 
is too high.

Not OK

L-shape

Not OK
Flat 

view:

Cross-sec-
tional view:

The back surface must be flat, with no difference in level.

The back surface 
is curved.

OK

The back surface 
is uneven.

Not OK Not OK
Flat 

view:

Cross-sec-
tional view:

* Conditions may vary if the optional kit material retainers are used.

(Without a head cap) The surface to be imprinted must be flat.

The surface to be imprinted 
is not straight.

Not OK
Flat 

view:

Cross-sec-
tional view:
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Preparing for Imprinting

Conditions for Material When Imprinting Curved Surfaces

The table and figure below show the imprint-assured area and the area reached by the marking pin with 
respect to the diameter of the cylinder with the extended curved surface. Note, however, that the following 
conditions are assumed.

• The head cap is used.

• Material with an extended curved surface has circularity.

Diameter of cylinder 
with extended curved 

surface (φ)
Recommended imprint area (A) Area reached by the marking 

pin (B)

10 mm (0.4 in.) 2.0 mm (0.08 in.) 2.8 mm (0.11 in.)

20 mm (0.8 in.) 2.8 mm (0.11 in.) 4.0 mm (0.16 in.)

30 mm (1.2 in.) 3.4 mm (0.14 in.) 4.8 mm (0.19 in.) 

(0.004 in.) (0.008 in.)

* Regardless of the shape or composition of the material, photographic data is not suitable for imprint-
ing on curved surfaces.

MEMO

Material to be imprinted that does not have a flat bottom must be secured using the material retainers from 
the optional kit or through some other means.

This section describes how to create imprint data using METAZAStudio.
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Starting METAZAStudio

Windows 10 and 7

1 Click the [Start] button.
2 Click [All Apps] ([All Programs] or [Programs] for Windows 7).
3 Click the [METAZAStudio] icon under the [METAZAStudio] folder.

Windows 8.1

1 On the [Start] screen, click .
2 On the [Apps] screen, click “METAZAStudio.”

 " P.49 "METAZAStudio Screen"

METAZAStudio starts.

Creating Imprint Data

2
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Creating Imprint Data

METAZAStudio Screen

No. Name Overview of Function

1 Menu bar Runs the various commands for METAZAStudio.
 " METAZAStudio online help (“Commands”)

2 Toolbar
The toolbar is provided with buttons for running METAZAStudio commands 
such as [Material] and [Open].

 " METAZAStudio online help (“Commands” - “Toolbar buttons”)

3 Page Feed Bar

When you have entered data into a variable field, use this to specify the page 
(record) that is displayed on the screen. Use this for Variable Imprinting.

 " P.90 "Creating Variable Imprinting Data"
 " METAZAStudio online help (“Hints and Tips” > “Performing Variable Imprinting”)

4 Status Bar

This shows the present location of the cursor, information about the shape, 
the grid, and the view magnification. Moving the pointer to a toolbar button 
or pointing to a menu command makes a brief explanation of the button or 
command appear at the left edge.

Present Cursor 
Position

This indicates the present location of the cursor. 
The position at the center of the window (where 
the two center lines intersect) is (0, 0).

Shape information

This appears when you click an on-screen object 
(image, text, or shape). The center position and 
size of the present shape are displayed, as shown 
in the figure below.

Grid Pitch
This displays the pitch (spacing) of the grid lines. 
Clicking the right mouse button over this displays 
menu items related to the appearance of the grid.

View Scaling Factor
This displays the present scaling factor for the 
screen view. Clicking the right mouse button over 
this displays a menu that lets you change the view 
scaling factor.

2
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Creating Imprint Data

No. Name Overview of Function

5 Grid table The machine’s grid table is shown here. The scale displayed represents the 
actual scale marks on the grid table.

6 Work Area
This is the area in which imprinting is possible. The material size (imprint 
area) set through METAZA Driver 2 is shown here.

 " P.104 "Changing Basic Driver Settings"

7 Center line This indicates the vertical and horizontal centers of the window.

8 Grid This is a grid of lines displayed in the work area. It serves as a guide for 
positioning images and text.

9 Margin

This blank area lies inside the edges of the work area and where no imprint-
ing is performed. The default setting upon installation of METAZAStudio is 
1 mm (0.04 in.). You can change the size of the margin by going to the [File] 
menu and selecting [Preferences].

 " P.51 "Step 1 : Determine the Shape and Size of Material"

2
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Creating Imprint Data

Step 1 : Determine the Shape and Size of Material
METAZAStudio has a number of different types of material preregistered. Using an example that uses a plate 
as described below, this section explains the procedure for using material with the same shape as the plate 
and with the name of “tag.”

 " P.42 "Preparing the Material"

25 mm (0.98 in.)

40mm

25mm

40 mm 
(1.6 in.)

MEMO

If you want to register new material, see the section given below.
 " P.102 "Registering a Composition and Adjusting the Striking Force"

Procedure

A Start METAZAStudio.
 " P.28 "How to Start The Software"

The [Select Material] dialog box appears.
If METAZAStudio is already running, click .

The [Select Material] dialog box appears.

2
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Creating Imprint Data

B Select the material in the [Select Material] dialog box.
Uncheck the [Use printer driver settings] checkbox to select a type of material. To use material that 
is not included in the list, you can register the material.
 " P.102 "Registering a Composition and Adjusting the Striking Force"

If you use the METAZA Driver 2 settings without changing them, check the [Use printer driver set-
tings] checkbox.

C  Click [OK].

D Click .

The [Material] window appears.

2
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Creating Imprint Data

E Select the shape of the material.
1 Click the icon with the “tag” name.
2  Click .

The [Material Size] dialog box appears.
3 Enter the values for the size of the material.
4 Click [OK].

2
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Creating Imprint Data

The material you selected appears in the Edit window. The portion displayed as the material becomes 
the imprint area without change.

F Click [File] → [Preferences].

The [Preferences] dialog box appears.

2
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Creating Imprint Data

G Set the margins.
1 Set “Margin” to “1 mm” (0.0394 in.).
2 Click [OK].

IMPORTANT

To imprint a flat material, make the margin at least 1 mm (0.0394 in.). If the margin is set to less than 1 mm 
(0.0394 in.), the marking pin may strike and damage the edge of the material.

2
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Creating Imprint Data

Step 2 : Import the Image
Import an image (such as a photograph or drawing) to be imprinted.

Data Formats Supported by METAZAStudio
• JPEG format

• BMP (bitmap) format

• Files in AI or EPS format created with Illustrator version 7 or 8

• Files in AI or EPS format exported by CorelDraw version 7 or 8

* Illustrator and CorelDraw files are subject to a number of limitations. For details, see the online help 
for METAZAStudio.

 " METAZAStudio online help (“Hints and Tips” > “Reusing Existing Data”)

Procedure

A Click .

The [Import] dialog box appears.

B Open the file.
1 At [Look in], select the location of the file.
2 Under [Files of type], select either [Picture file] or [Adobe Illustrator file].
3 Select the file you want.
4 Click [Open].
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Creating Imprint Data

The specified image is imported and displayed with the margins you set.

MEMO

You can vary the arrangement of the placed image such as by changing the size or orientation or by adding a 
border.
 " METAZAStudio online help (“Hints and Tips”)

IMPORTANT

If the material has holes, take care to ensure that the image is not laid out over the holes. If you include the 
holes in the imprint area, the marking pins might hit the edge of the material and cause damage.

Imprint area Imprint area

Imprint area

Imprint area

The imprint area 
lies over a hole.

No margins are 
present at the 
edges of the 
material.

The area to 
be imprinted 
extends beyond 
the material.

OK Not OK Not OK Not OK

1 mm 
(0.04 in.)

1 mm 
(0.04 in.)
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Creating Imprint Data

Step 3 : Type in the Text.
Type in the text to be imprinted.

Procedure

A Click .

B Enter text.
1 Click on the imprint area.
2 Enter text.
You can change the size and orientation of the typed text and fill it.
 " METAZAStudio online help (“Hints and Tips”)
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Creating Imprint Data

Step 4 : Save Imprinting Data
Save the imprint data to a file.

Procedure

A Click .

The [Save As] dialog box appears.

B  For [Save in], specify where to save the file.
 Type in a file name.
 Click [Save].
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Imprinting

Mounting the Material

1. Attach the head cap.

A Make sure that preparations for imprinting are completed.
 " P.40 "Preparing for Imprinting"

B If the head unit is lowered, press the Power/Movement button.
The head moves to the left rear.

C Loosen the head's stopper.
Rotate the knob once. The stopper and ring come into contact with each other.

Ring

Stopper

Loosen

D Fix the head's stopper.
Align the center of the knob with the top of the triangle directly below and then secure the stop-
per. If you perform imprinting while the stopper is loose, the knob might come off due to vibration.

Knob

Tighten

The center of the knob must 
be positioned immediately 
above the top of the triangle.

2
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Imprinting

E Attach a head cap to the tip of the head.
Mount it while lightly holding the head as shown in the figure. The head cap is attached correctly 
when its tab clicks.

Head 
cap

Head

Hold the head.

 Precautions for use of head cap

Remove dirt and dust from the imprint surface.
If you perform imprinting without removing dirt and dust attached to the printing surface, it may deteriorate 
the imprint quality. Make sure to remove dirt and dust from the imprint surface before performing imprinting.

For test imprinting, it is advisable to use materials with no scratches or stains.
Some material may cause scratches and stains on the head cap during imprinting, which may affect the imprint 
quality. Scratches and stains on the material may also damage the head cap and result in poor imprint quality. 
Therefore, before performing imprinting, we recommend you perform test imprinting with materials without 
any scratches or stains.

2.  Load the material on the grid table.

A Attach the base unit to the machine.
 " P.37 "Installing/Removing the Base Plate"

IMPORTANT

Attach the base unit in such a way that suits the thickness (height) of the material to be imprinted. If the 
configuration is not suited for the material, the imprint quality will be low and the machine may become 
damaged.
 " P.42 "Preparing the Material"
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Imprinting

B Place the base table (or grid table) on the base plate.
Insert the protrusions on the bottom of the grid table into the holes on the base table or base plate.

Using a base table + base plate

Grid table

Frame and holes on top 
of the base plate

Using a base plate only

Grid table

Base plate holes

C Affix the adhesive sheet to the grid table.

Grid table

Adhesive sheet for grid table

* The following illustrations show 
a machine with the base table 
attached.

Place the adhesive sheet straight within the grid table frame by aligning the sheet with the scale 
marks. Be careful not to allow any air bubbles to form between the grid table and the adhesive sheet.

MEMO

If the adhesive force has been reduced, wash the adhesive sheet. If the adhesive sheet must be washed, be 
careful not to damage the surface such as by rubbing with too much force. Doing so may damage the surface 
and reduce its adhesive strength.
 " P.109 "Cleaning the Adhesive Sheet"
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Imprinting

D Press the laser pointer button.

The laser pointer is irradiated. If the machine is idle for 5 minutes, the laser pointer is automatically 
turned off.

E Load the material on the adhesive sheet.

Laser
Handles

Imprint 
area

• Move the unit so that laser pointer points to the center of the area to be imprinted 
on the material.

• Gently press the material as if affixing it to the adhesive sheet.

MEMO

The position to which the laser pointer points coincides with the center of the work area in METAZAStudio. By 
making the position to which the laser pointer points coincide with the center of the area to be imprinted, you 
can print with the exactly same layout as the one displayed on the METAZAStudio's work area.

How to Place Material
• Place the material in a way that the center of the area to be imprinted comes to the 

center of the scale on the grid table.
• If the material is too large to fit in the grid table, use supports as necessary to keep 

the material horizontal.

Adhesive sheet
Center of 
imprint area

Material

Center line

Center line
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Imprinting

If you’re performing imprinting while using a head cap, this completes the loading of the mate-
rial. Proceed to P.66 "Making Imprints".
If you are not using a head cap, go to Step 3.

Using the head cap is usually recommended.

• When the head cap is used, the machine automatically tracks the surface height of the material and sets 
the position of the head. Imprinting is also possible on curved surfaces. (There is an upper limit to the 
height that can be tracked.)
 " P.47 "Conditions for Material When Imprinting Curved Surfaces"

• Imprinting without a head cap is limited to material with an even imprint surface placed horizontally.

3. Fix the height of the head. (When no head cap is used)

A Press the Power/Movement button with the head cap attached.
The head moves and stops at the position where the tip of the head cap sits on the surface of the 
material.

IMPORTANT

If no head cap is being used, be sure to attach a head cap at this time. If the head cap height is not 
set correctly, the desired imprint results may not be obtainable. The head may also become dam-
aged, or the material may become scratched.

B Loosen the head's stopper.
Rotate the knob once.

Loosen
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Imprinting

C Fix the stopper.
1 Lower the stopper to the bottom.
2 Fix the stopper.
Align the center of the knob with the top of the triangle directly below.

The center of the knob must be 
positioned immediately above 
the top of the triangle.

D Press the Power/Movement button.
The head moves to the left rear.

E Detach the head cap.

Support the head.

Head cap
Putting your fingers on the projecting 
rim of the head cap eases removal.

2
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Imprinting

Making Imprints

WARNING Keep your hands and body away from the moving portions of the machine 
during operation.
Hands and other body parts can become caught in the machine, resulting in injury.

After completing “Creating Imprint Data” and “Loading the Material,” imprinting starts.
 " P.48 "Creating Imprint Data", P.42 "Preparing the Material"

Procedure

A Click .
The [Print] dialog box appears.

B Set and confirm the preferences below.

Printer name Roland MPX-95

Material
Select the composition of the material and specify your priority regarding 
imprint quality (priority of quality or speed). The selection made when 
creating new imprint data is reflected in the material setting. 

Print Range
Use this option mainly for variable imprinting. (Normally, “All” is selected.)
To restrict records* to be imprinted, specify the records (page) that you 
wish to imprint. For example, to imprint only the 2nd to 5th records, select 
[Pages] and specify from page “2” to page “5.”

Copies
If imprinting the same material at multiple locations, specify a multiple 
number of copies. For example, if you wish to imprint the front and back 
sides of the instrument, specify “2” as the number of copies.

*Record: This refers to individual data included in the data for variable imprinting.
 " P.90 "Creating Variable Imprinting Data"
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C Click [OK].
Imprinting starts.

MEMO: Imprinting multiple copies or records

The message shown in the figure will appear when imprinting begins. Wait until imprinting is finished, and 
then go on to the next step.

D When imprinting is finished, replace the material or change its orientation.
 " P.60 "Mounting the Material"

IMPORTANT

Make sure to align the position using the laser pointer button every time the material is replaced.

E Click [OK].
Imprinting of the next page starts.

Variable Imprinting of Only the Displayed Records:

Click  .
The [Print] dialog box appears.
The number (page number) of the record being displayed in METAZAStudio is specified as the page 
under [Print Range]. Specify [Material] and [Copies] as necessary and click [OK] to start imprinting.
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Stopping Imprinting Operations
Hold down the Power/Movement button for one second or longer.
The light slowly blinks while the transmitted imprint data is being deleted. The light turns off and 
the power is switched off.

MEMO

When imprinting is paused, the head stays in the same position. The head will move to the left rear the next 
time the power is switched on.

Stopping Imprint Operations
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Stopping Imprint Operations

Deleting Data from Imprint Queue

Procedure

A Display the printer icon.

Windows 10 and 8.1

1 Right-click the [Start] menu on the computer.
2 Click [Control Panel].
3 Click [Devices and Printers].

Windows 7

1 Click the [Start] menu.
2 Click [Devices and Printers].

B Double-click the [Roland MPX-95] icon.

C From the [Printer] menu, click [Cancel All Documents] (or [Purge Print Documents]).

D If the message shown in the figure appears, click [Yes.]
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Processing Images

Keeping Only the Required Portion of an Image (Trimming)

METAZAStudio can cut an original image to remove unneeded areas and keep just the required portion.
This operation is called “trimming.”

Procedure

A Import the image.
 " P.56 "Step 2 : Import the Image"

B Select the image.
1 Click .
2 Click the image.

Eight trimming bars appear around the image.

C Trimming
Drag the trimming bar to trim the area you want to keep.

Trimming pointer

Configuring Advanced Settings / Processing Images

2
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Configuring Advanced Settings / Processing Images

Adjusting the Location, Size, or Angle of an Image

A Click .

B Adjust the position of the image.
1 Click the image.
() appear at the four corners of the image.
2 Drag the image to adjust its location.

2
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Configuring Advanced Settings / Processing Images

C Adjust the size of the image.
1 Click the image.
() appear at the four corners of the image.
2 Drag the handles at the four corners of the image to adjust the size.

Handles

D Adjust the angle of the image.
1 With the handles present at the four corners of the image, click the image a second 

time.
The shape of the handles at the four corners changes to ().
2 Line up the pointer with a handle.
The shape changes to a pointer for rotation.
3 Drag to adjust the angle of the image.
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Configuring Advanced Settings / Processing Images

MEMO

• Holding down the keyboard’s SHIFT key as you drag makes the angle change by 45 degrees at a time. 
Using this method can be convenient at times, such as when you want to perform rotation by precisely 
90 degrees.

• Trimming cannot be performed for an image whose angle has been changed. To perform trimming, first 
return the image to its original angle.

Enclosing an Image in a Frame

You can change the arrangement of the imprint data by placing a frame around an image. You use frames 
registered in what’s called METAZAStudio’s “library.” The library contains a number of preregistered frames, 
and you can register new ones.
 

 " METAZAStudio online help (“Hints and Tips” > “Making Use of Library”)

Procedure

A Click .
The [Library] window appears.
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Configuring Advanced Settings / Processing Images

B Insert a frame.
1 From [Group], select [Frame].
2 Select [Icon].
3 Click the [04] frame.
4 Click  .
A flame is inserted into the window.

C Adjust the size and location of the frame.
When the size of the frame is larger than that of the material, the result becomes as shown in the 
figure. The adjustment methods are the same as the methods for adjusting the location and size 
of an image.
 " P.71 "Adjusting the Location, Size, or Angle of an Image"

Handles
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Configuring Advanced Settings / Processing Images

Tips and Tricks for Text Layout

Adjusting the Location, Size, or Angle of a Text

You can change the location, size, and angle of placed text just as with an image.

Procedure

A Enter text.
 " P.58 "Step 3 : Type in the Text."

B Adjust the text position.
1 Click .
2 Click the laid-out text.
Eight handles appear around the text.
3 Drag the text to adjust its location.

C Adjust the size of the frame.
Drag the handles to adjust the size.
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Configuring Advanced Settings / Processing Images

D Adjust the angle of the text.
1 Click on the text and hold until the shape of the handles at the 4 corners changes 

to [●].
2 Line up the pointer with a handle.
The shape changes to a pointer for rotation.
3 Drag to change the angle of the text.

MEMO

Holding down the keyboard’s SHIFT key as you drag makes the angle change by 45 degrees at a time. Using 
this method can be convenient at times, such as when you want to perform rotation by precisely 90 degrees.

Arranging Text to a Fan Layout

A Enter text.
 " P.58 "Step 3 : Type in the Text."

B Click .
The [Properties] dialog box appears.
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Configuring Advanced Settings / Processing Images

C Set the text placement.
1 Click the Format tab.
2 Select the [Align with Curve] check box.
3 Click [OK].
The layout of the text changes to a fan shape.
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Configuring Advanced Settings / Processing Images

Laying Out Text along a Shape

Lay out text along a shape you have made using the drawing tools.

Procedure

A Create a shape.
1 Click the drawing tool.
Use  in this example.
2 In the editing window, create a shape on the material.

 " METAZAStudio online help (“Commands” - “Toolbar buttons”)

Drawing tools

B Click .
Position the pointer near the outline of the shape you created, and then click  when it appears 
under the pointer.
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Configuring Advanced Settings / Processing Images

C Enter text.
 " P.58 "Step 3 : Type in the Text."

The text is laid out along the shape.

IMPORTANT

Layout on an integrated polyline is not possible.
 " METAZAStudio online help (“Commands” > “[Object] menu” > “Convert to Polyline,” “Integrate Polyline”)

Filling Text

There are two ways to fill text: [Fill] and [Island Fill]. Select whichever method you desire.
 

Fill
Text is filled without space.

Island Fill
You can specify the interval between adja-
cent filling lines.

A Enter text.
 " P.58 "Step 3 : Type in the Text."

B Click .
The [Properties] dialog box appears.
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Configuring Advanced Settings / Processing Images

C Configure the Fill settings
1 Click the [Fill and Contour] tab.
2 Select the [Fill] check box.
3 Select [Fill] or [Island Fill].
When you select [Island Fill], you need to enter the pitch* as well.
*Pitch: Interval between adjacent filling lines
4 Click [OK].
The text is filled.

IMPORTANT

When performing imprinting with a lot of lines (Island Fill, etc.) on aluminum material or the like, the 
unevenness of the material surface is increased, and consequently the head cap will wear out faster. 
Periodically check the state of the head cap to ensure that it is replaced as often as needed.
 " P.113 "Head Cap Replacement"

Creating/Editing a Stroke Character Font

About Stroke Characters and SFEdit2

What are stroke characters?
All stroke characters are made up of polylines and lines.

What is SFEdit2?
SFEdit2 is a program for creating and editing stroke character fonts. As all stroke characters are made up of 
polylines and lines, you can add or delete anchor points and add line segments. In METAZAStudio, you can 
use the stroke character fonts that are created and edited using SFEdit2.
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Configuring Advanced Settings / Processing Images

SFEdit2 Window

No. Name Overview of Function

1 Menu bar Runs the various commands for SFEdit2.
 " SFEdit2 Help (“Commands”)

2 Toolbar
The toolbar is provided with buttons for running SFEdit2 commands such 
as [Open...] and [Save].

 " SFEdit2 help (“Commands” - “Toolbar buttons”)

3 Status Bar Moving the pointer to a toolbar button or pointing to a menu command 
displays a brief explanation of the button or command.

4 Character List This displays the list of all stroke characters. To edit the stroke character, 
click it.

5 Base line
This is the reference line for lining up a text string horizontally. When text 
is written horizontally, the base lines of adjacent characters are lined up 
along a horizontal line so that there is no unevenness.

6 Text box
This is a box for enclosing text. The size of the box differs according to the 
type of base font and the character. Normally you should create the text 
so that it fits inside the box.

7 Base font text This is displayed as a rough draft for editing stroke characters. A base font 
serves as the design base for a stroke character.

8 Stroke Characters

All stroke characters are made up of polylines and lines. All stroke characters 
can be edited by adding or deleting anchor points, adding line segments, 
and so on.

 " SFEdit2 help (“Operation Procedures” > “Step 2: Edit the shape of 
character”)  
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Creating a Stroke Character Font

The method of creating and saving a stroke character font is explained below.

Procedure

A  Start METAZAStudio.
 " P.48 "Starting METAZAStudio", P.28 "How to Start The Software"

B Click [Edit] → [Stroke Font] → [Run SFEdit2…].
SFEdit2 starts.

C Click [File] → [New…].
The [Select Base Font] dialog box appears.

D Create the stroke character.
1 Select a font to be used as the base for the stroke character font to be created.
2 Click [OK].

A stroke character font is automatically created.
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E Click .

The [Save] dialog box appears.

F Enter a name for the created stroke character font and save.
1 Enter the name of the created stroke character.
Giving a name based on the base font name allows you to easily identify the new name later. For 
example, “MS P Gothic_SF” is entered.
2 Click [OK].

The created stroke character font is saved.

G Click  .
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Change Entered Characters into Stroke Characters in a Stroke Character Font.

Make sure that either of the following operations is completed in advance.

Create a stroke character font before SFEdit2 is installed.
The window shown in the figure appears during installation. If you did not create a stroke character font 
at the time of installation, reinstall SFEdit2 and create a stroke character font.

 " P.24 "Installing the Driver and the Software", P.129 "To Install Software Separately"

Create a new stroke character font.
 " P.82 "Creating a Stroke Character Font"

Procedure

A Enter characters in METAZAStudio.
 " P.58 "Step 3 : Type in the Text."

B Click .
The [Properties] dialog box appears.
If the text box containing the entered characters is not selected, you cannot select . Be sure to 
select the text box.
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C Select the stroke character font.
1 Click the [Format] tab.
2 Select [Stroke].
The options for [Font] become limited to stroke character.
3 Select the stroke character font.
4 Click [OK].

Entered characters are changed into stroke characters. The stroke character font selected in 3 is 
used for the stroke characters.
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Editing Stroke Characters

Procedure

A Change an input character to a stroke character.
 " P.84 "Change Entered Characters into Stroke Characters in a Stroke Character Font."

B Begin stroke character editing.
1 Click .
2 Click the stroke character you want to edit.
Six pointers appear around the stroke character.
3 Click [Edit] → [Stroke Font] → [Edit Stroke…].

SFEdit2 starts.

C From the Character List, click the stroke character you want to edit.
The stroke character you want to edit is displayed in the virtual body and the stroke character be-
comes editable. Change the position and shape of the stroke character.
 " SFEdit2 help (“Editing Polylines”)

Character List
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D Close SFEdit2.
1 Click  .
The edit is overwritten to the selected stroke character font.
2 Click  .
SFEdit2 closes.

The edit is reflected to the stroke character.
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Checking and Adjusting Finished Result of an Image

Checking the Finished Results in the Preview Window

Click .

The Preview window appears.
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Adjusting the Finished Result in the Preview Window

In the preview window, you can adjust the brightness, contrast, and gamma correction. An image with clearly 
defined light and dark areas produces attractive imprint results.
 

No. Name Overview of Function

1 Brightness This adjusts the overall brightness. Making the value too large can destroy the 
balance, so it may be a good idea to adjust it to the absolute minimum necessary.

2 Contrast
This mainly adjusts highlights (the brightest areas) and shadows (the dark-
est areas). Using this can be effective when you want to achieve a sense of 
tension with a good balance of light and dark.

3 Gamma

This mainly adjusts the brightness of tones of intermediate brightness 
between bright and dark areas. Using it is effective in adjusting the overall 
brightness.
The dark and bright areas are imprinted as shown in the following figure.
Dark-color areas are not struck, and light-color areas are struck forcefully.

Dark area

Bright area

The imprint results before and after adjustment are as shown below.

Before adjusting After adjusting

Adjust the gamma to 0.4.
The brightness of the face is reduced, and the facial 
expression becomes clear.
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Creating Variable Imprinting Data
Imprinting a different object on each material after changing part of the print data is called “variable imprinting.” 
When performing variable imprinting, you no longer need to create new data each time you load a material. 
You can continue to print different data without interruption.

IMPORTANT

Continuous imprinting with varying data can only be done with material that is the same composition and size.

A CSV file is required to perform variable imprinting.

You can create a CSV file using database files. For information on creating a CSV file, contact the administrator 
of the databases.

1. Create a “variable field.”

MEMO: What is a variable field?

A variable field is a frame within which you can place text. With variable imprinting, data within the variable 
field is replaced with other data during imprinting.

A Starting METAZAStudio.
 " P.28 "How to Start The Software"

Select the material in the [Select Material] dialog box that appears.
If METAZAStudio is already running, click .

The [Select Material] dialog box appears.

2

Im
printing

90



Configuring Advanced Settings / Processing Images

B Select the material in the [Select Material] dialog box.
Uncheck the [Use printer driver settings] checkbox to select a type of material. To use material that 
is not included in the list, you can register the material.
 " P.102 "Registering a Composition and Adjusting the Striking Force"

If you use the METAZA Driver 2 settings without changing them, check the [Use printer driver set-
tings] checkbox.

C  Click [OK].

D Click the Insert Frame icon.
Click  and then .
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E Drag the mouse (move while holding down the left button of the mouse) diagonally 
downward on the work area* in METAZAStudio.
A variable field within which you can place text is created.
* Work area = black area on the screen

Work Area

F Click [Object] > [Move to Center].
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The center of the variable field moves to the center of the work area.

IMPORTANT : This work is important, being related to the actual imprint position.

In the machine, the center point of the imprint is defined as the imprint reference point. The “center of the work 
area” in METAZAStudio coincides with the reference point in the imprint operation. Consequently, making the 
“center of the variable field” coincide with the center of the work area means making the “center of the variable 
field” coincide with the “reference point in the actual imprint operation.”
Though you can imprint without making the center of the variable field coincide with the 
“reference point in imprinting operation,” making these points coincide with each other 
ensures the ease of placing text and images to be imprinted at the desired location.

G Click .
The [Properties] dialog box appears.

If the variable field is not selected, you cannot click . If you cannot click , click  and then 
click (select) the variable field.
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H Configure the settings for properties including the size of the variable field.
For details on each setting, refer to the help for METAZAStudio (“Commands” - “[Object] menu” - 
“Properties” - “[Properties] dialog box”).
 " P.28 "How to Display Help for Software"

After configuring the settings, click [OK].

2. Place text inside the variable field.

A Click [Load CSV File].
The [Open...] dialog box appears.
If the “Variable Printing” window is not displayed, click  .

B Specify a CSV file and click [Open].

The specified CSV file is imported into METAZAStudio.
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C Drag and drop the column title of the imported CSV file into the variable field.
Text is displayed in the variable field.

You can display each symbol in turn by clicking  . If you want to change the size or location 
of the variable field, open (click  ) the [Properties] dialog box and change the settings.
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Imprinting on Curved Surfaces
With this machine, using a head cap allows you to imprint curved surfaces. This section describes how to do 
so using imprinting on a semi-cylindrical material like the one shown below as an example.

50 mm 
(2.0 in.)

10 mm 
(0.4 in.)Diameter (φ) = 

20 mm (0.8 in.)

1. Set the imprint area.
First, configure the settings for the imprint area on the material. When imprinting a curved surface, imprint-
ing the entire surface of the material (as with flat material) is not possible. For this reason, the METAZAStudio 
editing window displays the imprint area instead of the material. The imprint area is determined by the value 
of the material’s diameter entered in the METAZA Driver 2 setting window.
For more information about the conditions of material with a curved surface that this machine can imprint, 
refer to the page indicated below.

 " P.47 "Conditions for Material When Imprinting Curved Surfaces"

A Click [File] → [Preferences].
The [Preferences] dialog box appears.
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B Set the margins.
1 Set “Margin” to “0 mm” (0 in.).
2 Click [OK].

MEMO

When imprinting a curved surface, the imprintable area is limited. To ensure a sufficient imprint area, set the 
margins to 0 mm (0 in.).

C Click [File] → [Set up the printer].
The [Print Setup] dialog box appears.
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D The printer’s [Properties] dialog box appears.
1 Make sure [Roland MPX-95] is chosen as the printer name.
2 Click [Properties].

E Enter the values for the size of the material.
1 Click the [Material] tab.
2 Enter the diameter.
In this example, set to 20 mm (0.8 in.).
3 Select [Direction].
Orient in the direction of the center vise.

: Vertical : Horizontal

 In this example, select (vertical).
4 Click [Enter].
Under [Work Size], the value for [Width] is set automatically. For [Length], in this example, set to 
50 mm (2.0 in.).
5 Click [OK].
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F Click [OK].

This concludes configuration of the imprint area settings.

2. Make horizontal writing on portrait material.

After the imprint area is determined, place images and text on the area. This section explains the method of 
inputting characters horizontally on portrait material.

A Enter the first letter.
1 Type in the text to be imprinted, and then adjust how it’s laid out.
2 Change the text size to your preferred size.
The text must fit within the imprint area.

B Rotate the input character to make it vertical.
 " P.75 "Adjusting the Location, Size, or Angle of a Text"
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C The cursor for entering text will appear.
1 Click .
2 Press the <→> key (left arrow key) on the keyboard.
The result becomes as shown in the figure.

D Input the remaining text and move the text to the desired position.
 " P.71 "Adjusting the Location, Size, or Angle of an Image"
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Registering a Wide Variety of Material
METAZAStudio includes four shapes of preregistered material. To imprint material not registered in METAZA-
Studio, first register it as a new material. This prevents the imprint area from being limited and the marking 
pin from being damaged as the result of hitting the edge of the material.
The following three methods are available for registering material. For detailed information about the proce-
dures, refer to the online help for METAZAStudio.

 " P.28 "How to Display Help for Software"
 " METAZAStudio online help (“Hint and Tips” > “Registering Favorite Material”)

Importing a Bitmap Image

If an image the same size of the material is available, you can import the image under the following conditions.
• File format: Must be either BMP (bitmap) or JPEG

• Colors: Binary (black and white)

• Portions corresponding to the material must be black-filled

Scanning the Material with a Commercially Available Scanner

When no image with the same shape of the material is available, or if the shape of the material is complex, 
you can scan the material on a commercially available scanner and import the image produced. In this regard, 
the requirements are as follows.

• Scanner: Scanner that supports TWAIN_32.

• Colors: Binary (black and white — portions corresponding to the material must be black-filled)

Drawing the Shape of the Material

If the material is a square, circle, or other such simple shape, you can use the drawing tools either singly or in 
combination to draw the shape of the material and then register it.
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Registering a Composition and Adjusting the Striking Force
With this machine, imprinting using a striking force appropriate to the composition of the material used al-
lows even higher quality imprint results to be obtained. METAZA Driver 2 for the machine has pre-configured 
settings for a number of materials and their appropriate striking forces, but you can also register materials 
and their optimal striking forces yourself. In order to obtain better imprint results, you can also carry out later 
adjustment of the striking force of compositions you’ve registered yourself.

Procedure

A Display the METAZA Driver 2 Printing Preferences screen.
 " P.26 "How to Open the METAZA Driver 2 Printing Preferences Screen"

B Select the imprint mode.
1 Click the [Image Correction] tab.
2 For [Material], select a custom material (settings a through d).
3 Select the imprint mode.

Text When you want to imprint text and other images with clear outlines

Photo When you want to imprint photographs and other images with gradation

High Resolution When you want to express small text and small patterns clearly

Other When you want to configure the resolution setting and other settings of an 
image

 " METAZA Driver 2 online help (“[Correction] tab”)

4 Click [Details].

The [Details] dialog appears.
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C Configure the detailed imprint mode settings.
1 Enter a name for the composition you’re registering.
2 Enter the speed and impact.
The imprint results vary according to the hardness of the material. Adjust to match the material.
 " METAZA Driver 2 online help ([Correction] tab > [Details] dialog box)

Impact--MIN
You can set the minimum value of imprint impact for an image. Raise the 
value when dark areas of the image are not struck. Lower the value when 
dark areas of the image are whitish or when overall striking is too forceful.

Impact--MAX
You can set the maximum value of imprint impact for an image. Raise the 
value when bright areas of the image are struck with too little force or when 
overall striking is too weak. Lower the value when bright areas of the image 
are struck with too much force.

Vector Impact You can set the maximum value of imprint impact for a line.

3 Select [Advance].
[Advance] is only available when [Other] is selected in  of Step B.
 " METAZA Driver 2 online help ([Correction] tab > [Details] dialog box)

Output  
Resolution

You can specify the number of dots per inch. As the number of the points 
becomes larger, the image will become more precise.

Drafting If you select “ON,” you can skip image information in increments of one dot.

4 Click [OK].

The [Details] dialog closes.
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Changing Basic Driver Settings

Procedure

A Display the printer icon.

Windows 10 and 8.1

1 Right-click the [Start] menu on the computer.
2 Click [Control Panel].
3 Click [View devices and printers] or [Devices and Printers].

Windows 7

1 Click the [Start] menu on the computer.
2 Click [Devices and Printers].

B Right-click the [Roland MPX-95] icon, and then click [Printing preferences].
The [Details] window for METAZA Driver 2 appears. Change the settings to suit your needs.

C After configuring the settings, click [OK].
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Description

METAZA Driver 2 allows you to configure the basic settings for a variety of items including the size of mate-
rial and the unit used for display. The basic settings continue to be applied by making the settings with the 
method previously described.
Though you can change these settings from METAZAStudio (From [File] menu, click [Print Setup] → [Proper-
ties] to display [Printing Preferences] shown in step C, any changes you make disappear when restarting 
METAZAStudio.

Other Operations Available with METAZAStudio
METAZAStudio includes a variety of other functions.
For information on the operation method, refer to the online help for METAZAStudio.

 " P.28 "How to Display Help for Software"

About Dr. Engrave

What is Dr. Engrave?

Dr. Engrave is imprinting software for plate materials.
This software can import a text file that includes data separated by commas or tabs into the character field. 
You can use files created with spreadsheet software and database software that have a text write function.
For more information, refer to the help for Dr. Engrave.

 " P.28 "How to Display Help for Software"

Points to Note When Using Dr. Engrave

• Setting of the material size (or the imprint area size) must be done in the setting window for METAZA Driver.
 " P.104 "Changing Basic Driver Settings"

• Set the material in a way that the center of the material (or the imprint area) comes to the center of the 
table (or the center vise).
 " P.60 "Mounting the Material"

2

Im
printing

105



Configuring Advanced Settings / Processing Images

Imprinting Thicker (Taller) Material
To imprint material thicker than 70 mm (2.8 in.), remove the base unit.

 " P.42 "Preparing the Material"

IMPORTANT

The imprinting position alignment accuracy will be lower compared with using the base unit. Perform a test 
imprint and fine-adjust the position before imprinting for production.

Procedure

A If the base unit is mounted on the machine, remove it.
 " P.37 "Installing/Removing the Base Plate"

B Mount the material so that the surface to be imprinted fits within the imprintable area.
Secure the material, and adjust the imprint height.
 " P.42 "Preparing the Material"

C Switching On the Power
 " P.32 "Switching On the Power"

D Press the Power/Movement button.
Lower the head to a position where it can detect the material height.

IMPORTANT

If the material height does not meet the conditions, an error will occur and the [Power/Movement] button will 
blink. Reload the material in a way that is suitable for the height.
 " P.42 "Preparing the Material", P.60 "Mounting the Material", P.118 "Was the material set in a way that is suitable 

for the material thickness (height)?"

E Press the Power/Movement button again.
The head moves to the left rear.

F Press the laser pointer button.
The laser pointer is irradiated. Adjust the position of the material so that laser pointer points at the 
center of the area to be imprinted on the material.

To continue, refer to P.66 "Making Imprints" and imprint.
We recommend carrying out a test imprint to verify the position.
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Points to Note on Daily Care

WARNING Never use gasoline, alcohol, thinner, or any other flammable material.
Doing so may cause a fire.

WARNING During repairs, part replacements, and similar work, never perform any 
operations that are not written in the user's manual.
Be sure to contact your authorized Roland DG Corp. dealer.

WARNING Perform this task with all power switches left switched off.
Failure to observe these instructions may cause the machine to move sud-
denly, resulting in injury.

CAUTION Never touch the heads immediately after imprinting has finished.
Doing so may cause burns.

• This machine is a precision device and is sensitive to dust and dirt. Be sure to carry out day-to-day cleaning.

• Never use solvents such as thinner, benzine, or alcohol.

• Never attempt to oil or lubricate the machine.

• Never apply silicone substances (oil, grease, spray, etc.) to the machine. Doing so may cause poor switch 
contact.

Daily Care
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Daily Care

Cleaning the Machine and Material Retainers
• Use a cloth moistened with water and wrung well, and wipe gently to clean.

• The surface of the cover is easily scratched, so use a soft cloth.

• For those using the material retainers from the optional kit, clean the grid table in the same way as the 
machine.

Cleaning the Adhesive Sheet
Buildup of dust or the like on the adhesive sheet can reduce the sheet's adhesive force, making it difficult to 
secure material in place. If the adhesive force has been reduced, wash the adhesive sheet.

How to Wash

Immerse the adhesive sheet in water, and wash the sheet by gently stroking its surface. If the soiling of the 
adhesive sheet is severe, wash it using diluted neutral detergent. Rinse thoroughly with water to remove all 
detergent completely.

IMPORTANT

Be sure to comply with the following instructions. If not, the surface of the adhesive sheet may become 
damaged, lowering the adhesiveness.

• Never scrub the adhesive sheet using a scrubbing pad or sponge.

• Never stretch or bend the adhesive sheet when washing it.

How to Dry

Allow to dry completely, out of direct sunlight.

Cleaning of the Head Cap
Detach the head cap from the machine and remove dirt and dust from the surface and the inside of the head 
cap. Imprinting without first removing dirt and dust from the head cap may damage materials and/or affect 
the imprint quality.
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Adjusting the Striking Force of the Pin
You can adjust the striking force of the pin by using MPX-95 Head Manager. Pin adjustment involves striking 
the pattern shown in the figure. You need to prepare the included test imprint material (brass) or a material 
equal to or larger than 60 mm (2.4 in.) wide by 60 mm (2.4 in.) long.
Adjustment pattern

Procedure

A Start MPX-95 Head Manager.
 " P.28 "How to Start The Software"

B Switch on the power to the machine.
 " P.32 "Switching On the Power"

C Click [Readjust Pin].

Adjusting
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The [Adjust Pin] wizard appears.
Follow the on-screen instructions to perform adjustment for the pin.

IMPORTANT

• Set a material to be imprinted with a test pattern using the adhesive sheet and grid table.

• Use a head cap.
 " P.60 "Mounting the Material"

If the adjustment pattern fails to be imprinted, refer to the sections given below.
 " P.120 "The Imprinted Location Isn't Where Desired."

D When you have finished, click  .
The window closes.

Adjusting the Origin Location
If the imprinted text or image is placed at a position that does not coincide with the desired position, the 
origin point of the machine has been displaced. Adjust the origin point using the method described below.

Procedure

A Start MPX-95 Head Manager.
 " P.28 "How to Start The Software"
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Adjusting

B Click [Adjust Origin].

The [Adjust Origin] wizard appears.
Follow the on-screen instructions to perform adjustment.

C When you have finished, click  .
The window closes.
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Replacing Consumable Parts

Head Cap Replacement
When the head cap becomes worn as shown in the figure below, it is time for replacement. Replace the head 
cap with a new one as necessary.
The degree of wear may vary according to imprint conditions. In particular, imprinting that makes extensive 
use of island fill* and other line-drawing operations on materials such as aluminum causes especially rapid 
wear because of the extensive unevenness of the material surface. Periodically check the state of the head 
cap to ensure that it is replaced as often as needed.

* Island Fill: Characters and objects (excluding Fill objects) are imprinted using lines placed at intervals. 
For details, refer to the help for METAZAStudio (“Commands” - “[Format] menu” - “Font” - “[Properties] 
dialog box”).

 " P.60 "Mounting the Material"

Head cap which needs to be replaced

Tab

Abraded

Tab

Head Replacement
The head should be replaced in the following cases.

• The head has reached the end of its service life.

• The marking pin is worn out.

A General Guide of Head Life

About 4,000 objects can be printed under the following conditions.

Material used MD-NI (Roland nickel-plated plate)

Imprint area 30 mm (W) × 23 mm (D) (1.2 in. × 0.9 in.)

Imprint mode Photo

Imprint rate 35% (25,000 dots per plate)

A message that indicates the head life also appears on METAZAStudio.
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Click [OK] to make the message disappear. Click [Details], and MPX-95 Head Manager appears.
 " P.114 "How to Check the State of the Marking Pin"

How to Check the State of the Marking Pin

You can check the state of the marking pin using MPX-95 Head Manager.

Procedure

A Start MPX-95 Head Manager.
 " P.28 "How to Start The Software"

B Switch on the power to the machine.
 " P.32 "Switching On the Power"

The amount of pin usage is indicated in this 
window. The level indicator increases little by little 
as the pin is used to strike the material. The rate 
of increase varies depending on the material being 
imprinted.

This refreshes the screen to display the latest 
information.
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MEMO

The indicator for [The amount of Pin usage] in MPX-95 Head Manager shows how much the marking 
pin has been used. The head should be replaced in the following cases.

• The indicator is shown in red.

• Although the indicator is not shown in red, attractive imprinting is impossible or images are uneven.

A worn-out marking pin is not the only reason for decreased imprint quality and uneven imprint 
results. Refer to the following pages to find the cause of the problem. If wear on the marking pin 
can be the cause of the problem, replace the head with a new one.
 " P.121 "The Imprinted Image Is Unattractive."
 " P.122 "The Image Is Uneven."

How to Replace the Head

MPX-95 Head Manager is used for replacing the head. The pattern shown in the figure is struck during the 
head replacement operation. You need to prepare a test imprint material (brass), which is supplied with a 
replacement head (MPH-90), or a material equal to or larger than 60 mm (2.4 in.) wide by 60 mm (2.4 in.) long.

* Replacement heads are sold separately. For purchasing information, contact your authorized Roland 
DG Corp. dealer or visit our website (http://www.rolanddg.com/).

Adjustment pattern

IMPORTANT

• Do not stop the replacement operation halfway.

• Do not use the head if the marking pin is worn out.

• Do not use a head that has been detached from the machine.

Procedure

A Start MPX-95 Head Manager.
 " P.28 "How to Start The Software"

B Switch on the power to the machine.
 " P.32 "Switching On the Power"
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C Click [Replace Head].
Follow the on-screen instructions to perform adjustment for the pin.

• Set a material to be imprinted with a test pattern using the adhesive sheet and grid table.
 " P.60 "Mounting the Material"

• Use a head cap.

• If the adjustment pattern fails to be imprinted, refer to the sections given below.
 " P.120 "The Imprinted Location Isn't Where Desired."

D When you have finished, click  .
The window closes.
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Troubleshooting

The [Power/Movement] Button Is Blinking.

Did you switch on the power 
with the height of the head 
position is fixed?

If the power is switched on while the height of the head position 
is fixed, the initial operation is stopped. If the machine continues 
the initial operation while the material is loaded, the material sur-
face may be scratched and/or the marking pin may be damaged.
Loosen the knob counterclockwise once. Then, while pushing 
the head's stopper against the ring, tighten the knob. Press the 
[Power/Movement] button to complete the initial operation, 
causing the lamp to stop blinking and light up.

Ring
Stopper

TightenLoosenTightenLoosen

The center of the knob must be positioned 
immediately above the top of the triangle.

If you’re not using a head 
cap, did you forget to adjust 
the height of the head posi-
tion?

The tip of the head hits the surface of the material. Switch off 
the power by holding down the [Power/Movement] button for 
one second or longer.
When imprinting without using the head cap, adjust the head 
position to an appropriate position based on the surface height 
of the material and secure the head firmly with the knob. If the 
head is fixed at the position that is lower than the surface height 
of the material, the tip of the head hits the surface of the material.

P. 60 "Mounting the Material"

Do you lift the head when you 
turn ON the power?

Because the head is lifted to the topmost, the machine deter-
mines that the surface height of the material does not meet the 
requirements for carrying out imprinting. Switch off the power 
by holding down the [Power/Movement] button for one second 
or longer.
When switching on the power, be careful not to touch the head 
unnecessarily.

Is a change in the height of 
the imprint surface too tall?

Switch off the power by holding down the [Power/Movement] 
button for one second or longer. Check the conditions of imprint-
able materials and select a material again.

P. 42 "Preparing the Material"

 Was the material set in a 
way that is suitable for the 
material thickness (height)?

Switch off the power by holding down the [Power/Movement] 
button for one second or longer.
The height that can be imprinted and the material surface height 
do not match. Because the setting method varies depending on 
the material thickness (height), reload the material in a way that 
is suitable for the height.

P. 60 "Mounting the Material"
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Is the knob loosened?

Switch off the power by holding down the [Power/Movement] 
button for one second or longer.
If the knob becomes loose during imprinting in the event that 
the head cap is not used, the head position will not match the 
surface height of the material. When you set the head position, 
make sure to tighten the knob firmly.

P. 60 "Mounting the Material"

The Machine Doesn't Run Even When Imprint Data Is Sent.

Is the power switched on?
Make sure the Power/Movement button light is on. If it is dark, 
press the Power/Movement button to switch on the power.

P. 32 "Switching On the Power"

Is the power cord connected 
correctly?

If it is not connected correctly, connect it properly.

P. 31 "Connecting the Machine to a Computer"

Is the cable used for the 
connection to the computer 
connected correctly?

Check if the connection cable is disconnected.

You Cannot Select the Material of the Object to Be Imprinted Using METAZAStudio.

Is the [Use printer driver set-
tings] checkbox checked?

If the [Use printer driver settings] checkbox is checked in the 
[Select Material] dialog box displayed directly after METAZAStu-
dio starts, you cannot select a material. Uncheck the [Use printer 
driver settings] checkbox.

Are you using a file created 
by an older version of 
METAZAStudio?

You cannot select a material using a file created by METAZAStudio 
with a version earlier than 2.00. Save the file using METAZAStudio 
with a version of 2.00 or later, and select a material.
You can check the version of your METAZAStudio on the window 
displayed by clicking the [Help] menu → [About] in METAZA-
Studio.
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The Imprinted Location Isn't Where Desired.

Is the material loaded at the 
correct location?

Verify that the base unit is installed correctly. Also verify that the 
laser pointer points to the center of the material to be imprinted 
and adjust the position as necessary.

P. 60 "Mounting the Material"

Striking is performed, but 
nothing is imprinted.

Does the material meet the requirements for imprinting with 
this machine?
Prepare and use imprintable material.

P. 42 "Preparing the Material"

If you’re not using a head 
cap, does the head position 
match the surface height of 
the material?

If you’re not using a head cap, check if the head position matches 
the surface height of the material. Imprinting cannot be per-
formed if the head position does not match the height position 
of the material. Adjust the head position and then tighten the 
knob firmly.

P. 60 "Mounting the Material"

Is the origin point of the ma-
chine displaced?

If the origin point is displaced, text and images will not be im-
printed at the desired position. Using MPX-95 Head Manager, 
adjust the origin point.

P. 111 "Adjusting the Origin Location"

Is the marking pin bent or 
broken?

If nothing is imprinted and changing the location where the 
material is loaded, the parameters for the material, or the height 
of the head unit does not correct the problem, then the marking 
pin may be bent or broken. Try changing to an unused marking 
pin and carry out test imprinting. If you can imprint with the new 
marking pin, it means the marking pin you were using is bent or 
broken. Continue using the new marking pin.

Not bent or 
broken

Bent or 
broken

Bent or 
broken

P. 113 "Head Replacement"
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The Imprinted Image Is Unattractive.

Are the settings for the mate-
rial correct?

Choose the composition of the loaded material in METAZAStudio.
Even if the composition of the material is the same, the hard-
ness of the imprint surface may vary greatly depending on the 
casting method, the composition of impurities, the presence of 
plating, and so on. In such cases, fine adjustment of the striking 
force is necessary.

P. 102 "Registering a Composition and Adjusting the Striking Force", P. 
51 "Step 1 : Determine the Shape and Size of Material" See Step B

Is the imprinted image 
blurry?

If the image is not imprinted clearly, adjust the brightness of 
the image.
Perform imprinting while increasing the brightness of [Gamma] 
or [Brightness] in the driver's setting window a little at a time. At 
this time, leave the material loaded and perform overstriking at 
the same location. While changing settings, continue to imprint 
until you obtain the condition you want.

P. 88 "Checking and Adjusting Finished Result of an Image"

Are grayscale tones imprint-
ed clearly?

When grayscale tones are indistinct, go to the setting window 
for METAZA Driver 2 ([Details] at the [Image Correction] tab) and 
adjust the force of striking. Perform imprinting while leaving the 
value for [Impact--MAX] unchanged and increasing the value for 
[Impact--MIN] a little at a time. At this time, leave the material 
loaded and perform overstriking at the same location. Continue 
changing the settings in the METAZA Driver 2 setting window and 
performing imprinting until you obtain the darkness you want.

About imprint results caused by overstriking and 
final setting values

Overstriking is a method where you can obtain desired 
imprint results by repeatedly striking the same location 
while changing the setting a little at a time. Therefore, 
although you imprint on a new material only once using 
the final setting value applied when performing overstrike, 
you cannot obtain the same imprint results as the one you 
obtain when performing overstrike.

P. 102 "Registering a Composition and Adjusting the Striking Force"

Is the marking pin worn?

Attractive imprinting may be impossible if the marking pin be-
comes worn. Check the state of the marking pin. If the marking 
pin becomes worn, replace the head with a new one.

P. 113 "Head Replacement"

Is the head cap worn?

Attractive imprinting may be impossible if the head cap becomes 
worn. Check the state of the head cap. If the head cap is worn, 
replace the head cap with a new one.

P. 113 "Head Cap Replacement"
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Troubleshooting

The Image Is Uneven.

Is the imprint surface slightly 
uneven? / Is the imprint sur-
face at an angle?

Attach a head cap and perform imprinting. If you’re using material 
that can be damaged by imprinting with the head cap attached, 
then replace the material with one that has a level imprint surface.

P. 61 "Precautions for use of head cap"

Is the image darkness uneven?

Performing overstriking may improve the image quality. With the 
material left loaded, try performing overstriking with different 
settings for [Gamma], [Brightness], or [Contrast] in the preview 
window.

P. 88 "Checking and Adjusting Finished Result of an Image"

Was bidirectional imprinting 
performed?

Bidirectional imprinting can shorten the imprint time, but the 
image quality may suffer. If this happens, go to the METAZA Driver 
2 setting window and clear the selection for [Bidirection], then 
perform imprinting again.

METAZA Driver 2 online help (“[Material] tab”)

Is the marking pin worn?

Attractive imprinting may be impossible if the marking pin be-
comes worn. Check the state of the marking pin. If the marking 
pin becomes worn, replace the head with a new one.

P. 113 "Head Replacement"

Is the head cap worn?

Attractive imprinting may be impossible if the head cap becomes 
worn. Check the state of the head cap. If the head cap is worn, 
replace the head cap with a new one.

P. 113 "Head Cap Replacement"
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Troubleshooting

The Image Is Always Faint at the Same Location.

Is a change in the height of 
the imprint surface too tall?

If the image is always faint at the same location even though 
you’re performing imprinting using a head cap, the imprint 
surface may have an excessive height displacement. Recheck 
the requirements for the material that can be imprinted by the 
machine and select a material that meets the requirements. Also, 
image quality is not assured when imprinting photographic data 
on a curved surface with this machine.

P. 42 "Preparing the Material"

The machine may tilt slightly.

If the image is often faint at the same location, such as near the 
front right area of the grid table, the machine may tilt slightly. 
Adjusting the levelness of the machine may improve the image 
quality. Adjust the levelness of the machine according to the 
following procedure.
Please note that this is not effective when unevenness in the 
image is unrelated to the imprint location, such as when uneven 
areas vary from one piece of material or image to another. We 
recommend using a head cap whenever possible.

Adjusting the Machine Angle

Procedure

A Mount the included test material on the grid table.
• Using the adhesive sheet, set it in the center of the grid table.
• If the included material has been used up, then prepare a piece of material that is 

larger than 60 mm (2.4 in.) and has a smoothness of 0.05 mm (0.002 in.) or less.
• Perform imprinting without using the head cap.
 " P. 60 "Mounting the Material"

B Display the printer icon.

Windows 10 and 8.1

1 3. Right-click the [Start] menu on the computer.
2 Click [Control Panel].
3 Click [View devices and printers] or [Devices and Printers].

Windows 7

1 Click the [Start] menu.
2 Click [Devices and Printers].
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Troubleshooting

C Right-click the “Roland MPX-95” icon, and then click [Printing preferences].
The METAZA driver 2's Printing Preferences screen opens.

D Click [Test Print] in the [Option] tab.

The test pattern is imprinted on the material.

E Use the scale to read and note the locations where the test pattern is not continuous or not visible.
Note the values in all four directions (front, back, left, and right).

Right

Front

Back

Left
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F Enter the correction value.
1 Select [Correct slope]
2 Enter the scale values you noted in E into METAZA Driver 2.
3 Click [OK].
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Troubleshooting

Installing the Driver Separately
You can install METAZA Driver 2 and the software at the same time. To install all at the same time, see P. 24 

"Installing the Driver and the Software".

Procedure

A Log on to Windows as an administrator or as a member of the Administrators group.

B Insert the Roland Software Package CD-ROM into the computer.
When the automatic playback window appears, click [Run menu.exe]. The setup menu appears 
automatically.

C Uninstall METAZA Driver 2 if it has been already installed.
 " P. 131 "Uninstalling Driver"

Go to Step D if the driver is not installed or has been uninstalled.

D Click [Custom Install].

E Click [Install] for METAZA Driver 2.

4

Trouble-
shooting 

126



Troubleshooting

F Select [Install], select [MPX-95] as the model name, select [USB] as the port, and then 
click [Start].

METAZA Driver 2 installation starts. Proceed by following the on-screen instructions.
Perform the following actions if the screens shown below appear during installation.

Windows 10

Click [Install].

Windows 8.1

Click [Install].

Windows 7

Click [Install this driver software anyway].

G When the screen shown here is displayed, click [Finish].

4

Trouble-
shooting 

127



Troubleshooting

H Click  of the setup menu.

I Remove the CD from the CD-ROM drive.

J Connect the machine to the computer using the USB cable.
Please use the included USB cable. Do not use a USB hub.

METAZA Driver 2 is installed automatically.
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Troubleshooting

To Install Software Separately

Procedure

A Log on to Windows as an administrator or as a member of the Administrators group.

B Insert the Roland Software Package CD-ROM into the computer.
When the automatic playback window appears, click [Run menu.exe]. The setup menu appears 
automatically.

C Click [Custom Install].

D Click [Install] of the program you want to install.
 " P. 23 "The Software You Can Install and Set Up"

For information about METAZA Driver 2 installation, refer to P. 126 "Installing the Driver Separately".

E Follow the messages to install the software.
If the [User Account Control] appears, click [Allow] to install the software.

F When installation finishes, click  of the setup menu.

G Remove the CD from the CD-ROM drive.
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Driver Installation Is Impossible
If installation quits partway through, or if the wizard does not appear when you make the connection with a 
USB cable, installation of METAZA Driver 2 may not be possible. In such cases, perform the following procedure. 
(If procedure A does not solve your problem, perform procedure B.)

Windows 10/8.1 (procedure A)

1. Connect the machine to the computer using the USB cable, and switch on the power to the machine.
2. Click [Desktop].
3. Right-click the [Start] button, and then click [Control Panel].
4. Click [View devices and printers] or [Devices and Printers].
5. Check that the model you are using is displayed under “Unspecified.”
6. Right-click the icon of the model you are using, and then click [Remove device].
7. If the message “Are you sure you want to remove this device?” is displayed, click [Yes]. 
8. Check that the icon for the model you are using is no longer displayed under “Unspecified.”
9. Temporarily disconnect the USB cable connecting the machine to the computer, and then reconnect these 

devices. If the printer icon for the machine you are using is displayed under “Printer,” the Windows driver 
has been successfully installed.

If this does not solve the problem, perform the procedure under “Windows 10 / 8.1 (procedure B).”

Windows 10/8.1 (procedure B)

1. Connect the machine to the computer using the USB cable, and switch on the power to the machine.
2. If the [Found New Hardware] appears, click [Cancel] to close it. Disconnect any USB cables for printers other 

than this machine.
3. Click [Desktop].
4. Right-click the [Start] button, and then click [Device Manager].
5. If the [User Account Control] window appears, click [Continue]. The [Device Manager] appears.
6. From the [View] menu, click [Show hidden devices].
7. In the list, find and double-click [Printers] or [Other devices]. Click the model name or [Unknown device], 

whichever appears below the item you selected.
8. From the [Action] menu, click [Uninstall].
9. In the “Confirm Device Uninstall” window, click [OK]. Close [Device Manager].
10. Detach the USB cable from the computer, and then restart Windows.
11. Uninstall the Windows driver. Carry out the steps from step 3 on P. 131 "Windows 10/8.1" to uninstall the driver.
12. Reinstall the driver again according to the procedure in “Setup Guide” (“Installing the Software”) or P. 126 

"Installing the Driver Separately".

Windows 7 (procedure A)

1. Connect the machine to the computer using the USB cable, and switch on the power to the machine.
2. Click the [Start] menu, and then click [Devices and Printers].
3. Check that the model you are using is displayed under “Unspecified.”
4. Right-click the icon of the model you are using, and then click [Troubleshooting].
5. If the screen shown here is displayed, click [Install this driver software anyway].
6. If a message is displayed asking you to “Set as default printer,” click [Skip this fix].
7. If the message “Troubleshooting has completed” is displayed, click [Close the troubleshooter].

If the printer icon for the machine you are using is displayed under “Printer,” the Windows driver has been suc-
cessfully installed. If this does not solve the problem, perform the procedure under “Windows 7 (procedure B).”
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Windows 7 (procedure B)

1. If the [Found New Hardware] appears, click [Cancel] to close it.
2. Click the [Start] menu, and right-click [Computer]. Click [Properties].
3. Click [Device Manager]. When the [User Account Control] window appears, click [Continue]. The [Device 

Manager] appears.
4. From the [View] menu, click [Show hidden devices].
5. In the list, find and double-click [Other devices]. Click the model name or [Unknown device], whichever 

appears below the item you selected.
6. From the [Action] menu, click [Uninstall].
7. In the “Confirm Device Uninstall” window, select [Delete the driver software for this device.], then click [OK]. 

Close [Device Manager].
8. Detach the USB cable from the computer, and then restart Windows.
9. Uninstall the Windows driver. Carry out the steps from step 3 on P. 132 "Windows 7" to uninstall the driver.
10. Reinstall the driver again according to the procedure in “Setup Guide” (“Installing the Software”) or P. 126 

"Installing the Driver Separately".

Uninstalling Driver
When uninstalling METAZA Driver 2, perform the following operation.

Windows 10/8.1

*If the driver is uninstalled without following the procedure given below, there is a possibility that re-installation 
may not be possible.

1. Switch off the power to the machine, and then detach the connector cable between the machine and the 
computer.

2. Log on to Windows as an administrator.
3. Click [Desktop].
4. Right-click the [Start] button, and then click [Control Panel].
5. Click [Uninstall a program] or [Programs and Features].
6. Click the Windows driver for the machine to delete to select it, and then Click [Uninstall]. If the [User Ac-

count Control] appears, click [Allow].
7. If a message prompting you to confirm deletion appears, click [Yes].
8. Click [Start] and then click [Desktop].
9. Open Explorer, and then open the drive and folder containing the Windows driver. (*)
10. Double-click “SETUP64.EXE” (64-bit version) or “SETUP.EXE” (32-bit version).
11. If the [User Account Control] window appears, click [Allow]. The setup program for the Windows driver starts.
12. Click [Uninstall]. Select the machine to remove and click [Start].
13. If it is necessary to restart your computer, a window prompting you to restart will appear. Click [Yes].
14. After the computer has restarted, open the Control Panel again, and click [View devices and printers] or 

[Devices and Printers].
15. If you can see the icon of the machine to remove, right-click it and click [Remove device].

(*)
When using the CD-ROM, specify the folder as shown below. (This is assuming your CD-ROM drive is the 
D drive.)
D: \Drivers\X64 (64-bit version)
D: \Drivers\X86 (32-bit version)
If you're not using the Roland Software Package CD, go to Roland DG Corporation’s website (http://www.
rolanddg.com) and download the Windows driver for the machine you want to remove, and then specify 
the folder where you want to extract the downloaded file.
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Windows 7

*If the driver is uninstalled without following the procedure given below, there is a possibility that re-installation 
may not be possible.

1. Before starting uninstallation of the driver, unplug the USB cable from your computer.
2. Log on to Windows as an administrator.
3. From the [Start] menu, click [Control Panel]. Click [Uninstall a program] or [Programs and Features].
4. Click the Windows driver for the machine to delete to select it, and then Click [Uninstall].
5. If a message prompting you to confirm deletion appears, click [Yes].
6. On the task bar, click [Start], [All Programs], [Accessories], [Run], and then [Browse].
7. Choose the name of the drive or folder where the Windows driver is located. (*)
8. Select “SETUP64.EXE” (64-bit version) or “SETUP.EXE” (32-bit version) and click [Open], and then click [OK].
9. When the [User Account Control] window appears, click [Allow].
10. The setup program for the Windows driver starts.
11. Click [Uninstall]. Select the machine to remove and click [Start].
12. If it is necessary to restart your computer, a window prompting you to restart will appear. Click [Yes].
13. The uninstallation finishes after the computer restarts.

(*)
When using the CD-ROM, specify the folder as shown below. (This is assuming your CD-ROM drive is the 
D drive.)
D: \Drivers\X64 (64-bit version)
D: \Drivers\X86 (32-bit version)
If you're not using the Roland Software Package CD, go to Roland DG Corporation’s website (http://www.
rolanddg.com) and download the Windows driver for the machine you want to remove, and then specify 
the folder where you want to extract the downloaded file.

4

Trouble-
shooting 

132



133

Moving the Machine

IMPORTANT

When moving the machine, be sure to carry out the removal/attachment procedures described below. Moving 
the machine without doing so may result in damage to the machine.

1. Remove all included items attached to the machine.

A Make sure the power is switched off.

B Open the cover of the machine.

C If the base unit has been removed, install it.
 " P. 37 "Installing/Removing the Base Plate"

D If a grid table is mounted on the base unit, remove it.
In addition to the grid table, if the optional kit material retainers are mounted, remove them as well.

Grid table
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2. Attach a head cap to the head.

Head 
cap

Head

Hold the head.

3. Attach the retaining materials.

A Hold down the Power/Movement button for ten seconds or longer.
The head moves as shown below.

 

B Fix the head at the highest position.
1 Loosen the knob.
2 Lift the head to the highest position and tighten the knob.

Tighten

Head

Loosen

Lift the head.The center of the knob must 
be positioned immediately 
above the top of the triangle.

4

Trouble-
shooting 

134



Moving the Machine

C Remove the power cord and USB cable.

D Attach the retaining materials.
The machine is secured with retainers and screws at five points (  through  below). Attach 
all the retainers and tighten the screws with the included hexagonal wrench. For information on 
where to store Retainer A, Retainer B, and the retaining screws, refer to P. 30 "Removing the Retainers".

Items Used Retainer

Hexagonal 
wrench

Retainer A (2) Retainer B (1 each for L and R) Retaining screws 
(7)

Retainer B

Secure to the 
left and right 
sides of the 
machine.

Retainer A

Retainer A

E Close the cover and repack the machine.
When moving the machine, be sure to support it at the bottom using two hands. Attempting to 
move the machine by holding it at a different location may result in damage.
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Imprint Area

Maximum Imprinting Area and Recommended Imprinting Area

70 mm (2.8 in.)

Machine side

(Distance from machine)

80 mm 
(3.2 in.)

118 mm (4.6 in.)

Center line

Center line

Top view of the grid table

Recommended imprint area
(50 mm × 50 mm (2.0 in. × 2.0 in.))

80 mm (3.2 in.)

50 mm (2.0 in.)

50 mm 
(2.0 in.)

80 mm 
(3.2 in.)

Maximum imprint area (80 mm × 80 mm (3.2 in. × 3.2 in.))
Setting configuration through METAZA Driver 2 is required.
If an image exceeds the imprintable area, the print result 
might become uneven outside of the imprintable area.

Main Unit Specifications
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Main Unit Specifications

Location of Power Rating and Serial Number Label

Power Rating
Use an electrical outlet that meets the 
requirements for voltage, frequency, and 
amperage given here.

Back surface

Serial number
This is required when you seek mainte-
nance, servicing, or support. Never peel 
off the label or let it get dirty.

Power Rating
Use an electrical outlet that meets the 
requirements for voltage, frequency, and 
amperage given here.

AC adapter
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Main Unit Specifications

Specifications

MPX-95

Imprintable material Gold, silver, copper, platinum, brass, aluminum, iron, stainless steel, etc.
(Vickers hardness [HV] of the imprint surface must be 200 or less.)

Loadable material 
size

Using a base table + base plate:
Max. 100 mm (W) × 200 mm (L) × 40 mm (H) (3.9 in. × 7.9 in. × 1.6 in.)
or 200 mm (W) × 100 mm (L) × 40 mm (H) (7.9 in. × 3.9 in. × 1.6 in.)

Using a base plate only:
Max. 100 mm (W) × 200 mm (L) × 70 mm (H) (3.9 in. × 7.9 in. × 2.8 in.)
or 200 mm (W) × 100 mm (L) × 70 mm (H) (7.9 in. × 3.9 in. × 2.8 in.)

*The above are for when the cover is closed. When the cover is open, there is no 

limit on how large the material can be, but the imprint area of the material 

must be placed within the imprint area.
 " P. 138 "Imprint Area"

Imprint area Maximum Imprint-
able Area

80 mm (W) × 80 mm (D) × 70 mm (H) (3.2 in. × 3.2 in. 
× 2.8 in.)

Recommended im-
print area

50 mm (W) × 50 mm (D) × 70 mm (H) (2.0 in. × 2.0 in. 
× 2.8 in)

Resolution 529 dpi (High resolution), 353 dpi (Photo), 265 dpi (Text), 1058 dpi (Vector)

Imprint direction Unidirectional imprinting or bidirectional imprinting (Selectable with Windows 
driver)

Imprint speed  
(Default)

50 mm/sec (2.0 in./sec) (Photo), 33 mm/sec (1.2 in./sec) (High resolution/Text), 
24 mm/sec (0.94 in./sec) (Vector)

Interface USB

Power requirements D e d i c a t e d  A C 
adapter

AC 100 to 240 V ±10%, 50/60 Hz

Main unit DC 19 V, 1.2 A

Power consumption Approx. 21 W

Operating noise 70 dB (A) or less

Operating tempera-
ture

10 to 30°C (50 to 86°F)

Operating humidity 35 to 80% (no condensation)

External dimensions 286 mm (W) x 383 mm (D) x 308 mm (H) (11.3 in. (W) x 15.1 in. (D) x 12.2 in. (H))

Weight 12 kg (26.5 lb.)

Included items AC adapter, power cord, test-use material, USB cable, Roland Software Package 
CD-ROM, user's manual, etc.

System Requirements for USB Connection

Computer Model preinstalled with Windows 10, 8.1, or 7 (32- or 64-bit), or upgraded 
computer originally preinstalled with Windows 7 or later

USB cable Use the included USB cable.
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